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1. Introduzione

L'ambiente di sviluppo QVIEW (QMOVE Viewer), il linguaggio QCL (QEM Control Language) e il linguaggio LADDER (logica
contatto), sono gli strumenti necessari per lo sviluppo, il debug e la modifica dei progetti per il sistema QMOVE. La potenzialita
di questa combinazione di hardware e software permette di sviluppare controlli per I'automazione industriale, con particolare
riguardo alla gestione della movimentazione (elettrica, idraulica, CNC o ON / OFF).

1.1 QVIEW: QMOVE VIEWer

Come ogni linguaggio strutturato e compilato, anche il QCL ed il Ladder necessita di un editor per digitare le righe di codice e di
un compilatore che le traduca in linguaggio macchina controllandone la sintassi; QVIEW & I'ambiente di sviluppo che, oltre a
supportare il linguaggio QCL ed il linguaggio Ladder, permette di trasferire il programma nella CPU del sistema QMOVE, di
monitorare e modificare tutte le variabili ed i parametri del programma ed eventualmente interromperne I'esecuzione per
comprendere e correggere eventuali funzionamenti non desiderati (DEBUG).

1.2 QCL: QEM Control Language

I QCL ¢ un linguaggio di tipo strutturato la cui sintassi e i cui comandi risulteranno familiari a chi si occupa gia di
programmazione o che comunque ha avuto modo di fare esperienza con un linguaggio ad alto livello. Chi invece si addentra
per la prima volta nel mondo dei linguaggi strutturati potra trovare in questo manuale un valido supporto di apprendimento.

1.3 Ladder

Il Ladder & un linguaggio a contatti logici il cui uso sara familiare a chi si occupa di programmazione PLC. Chi invece si addentra
per la prima volta nel mondo ladder dovra provvedere ad integrare il presente manuale con un corso PLC generico.

1.4 1 Device

| device sono delle funzionalita messe a disposizione del programmatore. Essi svolgono le funzioni tipiche dell’automazione
industriale, dalla lettura di un ingresso analogico, alla lettura di un segnale proveniente da un traduttore di posizione, fino ad
eseguire dei veri e propri posizionamenti di assi. Ogni device & dotato di un manuale specifico, si rimanda percid alla
documentazione relativa.

1.5 QPaint

Una applicazione di prodotti QEM in una automazione industriale puo aver bisogno sia di un progetto sviluppato in Qview (per il
controllo e I'automazione) e sia di un progetto per tutto quello che riguarda I'interfaccia con l'operatore. QPaint & I'ambiente
per lo sviluppo dell'interfaccia grafica per i terminali operatore QEM. | due progetti sono legati tra di loro perché fanno
riferimento alla stessa struttura dati (variabili, array, ecc.).
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2. Introduzione all’ambiente

In questa sezione verra introdotto I'ambiente di sviluppo (QVIEW) presentando un semplice esempio. L'esempio & un supporto
alla sperimentazione pratica durante |I'apprendimento.
Le fasi fondamentali che verranno sviluppate possono essere riassunte in:

Apertura e creazione del progetto di esempio.

Compilazione del progetto di esempio.

¢ Connessione del PC al QMOVE.

Trasferimento del progetto compilato nella CPU (Download).
Monitoraggio del funzionamento.

2.1 Apertura e creazione del progetto di esempio

QVIEW 6.0 & uno dei software del pacchetto QWorkbench. Una volta installato e avviato il QVIEW 6.0, la schermata iniziale
appare come in Figura 1.

Figura 1: Primo avvio

P B Pt Cstag Skrdm Opao Hep
“H" -l..
TEA4 Ak 44 | r

Fra Comacaon

* Nella parte superiore dello schermo sono posizionati i vari menu da cui & possibile effettuare tutte le
operazioni consentite.

e Appena sotto vi e la barra degli strumenti dove si pud avere accesso a tutte le operazioni di base piu
usate.

¢ Nella parte inferiore dello schermo si trova una barra di stato per un riepilogo delle informazioni
importanti.

¢ Sulla zona grigia sarai in grado di mettere tutte le finestre necessarie per sviluppare, eseguire il debug e
monitorare (Area di lavoro).

» Nella zona bianca ¢ possibile elencare le unit che compongono il progetto o I'elenco dei elementi ladder
possibile utilizzare.

2.1.1 Creare un nuovo progetto

Per creare un nuovo progetto devi selezionare:
¢ File - New Project
e scrivere il nome del progetto come “FirstApp”. Viene visualizzata la finestra per avere alcune informazioni sul progetto. Per

ora ¢ possibile lasciare perdere. Sara possibile compilare questo modulo in un secondo momento. Ora & possibile salvare il
progetto per creare il file di progetto. Seleziona:
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¢ File - Save

e scegliere una directory dove vuoi salvare il progetto. Ora bisogna creare le due units fondamentali per creare un progetto
minimale che possa essere compilato. Selezionare:

¢ File - Add Unit - Configuration Unit

lasciare il Unit Name come CONFIG e premere OK. Come si vede una nuova unit € apparsa nell'area bianca e una finestra di
editor & apparsa nella Work Area. In questa nuova finestra sara possibile vedere le linee di codice che compongono la unit.
Andiamo ora a modificare questa unit. La Configuration Unit & unica nel progetto (non ne possono essere aggiunte altre di
questo tipo) ed & utilizzata per dichiarare le variabili o le strutture dati del progetto, per dichiarare quali device si vogliono
usare e per dichiarare per quale tipo di hardware si sta sviluppando il progetto.

2.1.1.1 Configuration unit

In questo momento & necessario sapere che la unit di configurazione e dove:

e si dichiarano le costanti, variabili, matrici, ingressi digitali e uscite digitali. Ognuno di questi simboli &
leggibile e scrivibile in tutto il progetto (in seguito vedremo come si possa dichiarare le variabili con
visibilita locale);

e sidichiara I'nardware che si sta utilizzando;

e si dichiarano tutti i devices che si desidera utilizzare nel progetto.

Ora é necessario inserire alcuni cambiamenti della unit di configurazione. Cercare la parola chiave SYSTEM nella unit (e
possibile usare lo strumento di ricerca con CTRL+F). Verra trovato questo codice:

count L ;This is a variable use as a counter
Con questa sintassi & stata dichiarata la variabile count, il suo tipo & L (Long) e essa appartiene al gruppo SYSTEM.

e SYSTEM: & un gruppo di variabili che memorizzano il loro valore allo spegnimento del sistema. Alla
riaccensione tale valore viene mantenuto.

e Long: & un tipo di variabile che occupa 4 bytes in memoria. Variabili di questo tipo possono contenere
valori compresi tra -2147483648 and 2147483647,

e count: & il nome assegnato alla variabile.

| Tutte le linee di codice che iniziano con “;” sono commenti del programmatore. Esse non hanno effetto esecutivo sul progetto. |

Un'altra operazione & I'indicazione della composizione del QMOVE sistema. Prima di tutto bisogna cercare la parola chiave BUS.

Queste righe di codice dipendono dal tipo di hardware per cui sta sviluppando il progetto. Nella documentazione di installazione
del controllo gmove in uso, € possibile ottenere le informazioni relative alla configurazione della sezione BUS.

2.1.1.2 QCL unit

Aggiungere una nuova unit al progetto. Seleziona:
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¢ File - Add Unit - QCL Unit
lasciare il nome della unit a UNIT1 e premere OK. Otterremo una seconda unit con il seguente codice gia scritto:

MAIN:
WAIT 1
JUMP MAIN
END

cambiare in questo modo:

MAIN:
count = count + 1
WAIT 1
JUMP MAIN

END

Le unit di questo tipo possono essere pil di una in un progetto. Il codice compreso tra |'etichetta MAIN e l'istruzione JUMP MAIN
e ripetuto continuamente come in un ciclo infinito. La linea di codice count = count + 1 incrementa di 1 il valore della variabile
count ad ogni ciclo.

2.1.2 Compilazione del progetto di esempio

Prima di trasferire il progetto nella CPU, bisogna sempre compilarlo. E' possibile avviare la compilazione dal menu:
e Project - Compile

Alla fine della compilazione, alcuni messaggi ti informeranno dei risultati ottenuti. Nell'esempio che abbiamo appena creato il
risultato non dovrebbe avere errori e quindi otterremo Project compiling OK!.

2.2 Connessione del PC al QMOVE

Prima di poter aprire il collegamento & necessario che sia attivo il gestore delle risorse QRM (Qem Resurces Manager). Si trova

r“?
tra le icone in basso a sinistra della barra degli strumenti di Windows. La sua icona & . Se questa icona & presente significa
che il QRM & attivo. Altrimenti sara necessario avviarlo trovandolo nel pacchetto QWorkbench.
La connessione puo avvenire sia via seriale tramite il convertitore 1Q009 convertitore 1Q009, sia tramite il collegamento tra la
porta Ethernet del PC e la porta Ethernet del Qmove (per i modelli che ne sono provvisti).
Per poter trasferire il progetto compilato alla CPU bisogna connettere il PC al sistema QMOVE. Selezionare:

e Options - Open Connection

Appare la finestra “Connection Resources”. Cliccare con il tasto destro su Serial Com e selezionare Edit Resource Property....
Per un semplice collegamento seriale & necessario solo assicurarsi che il numero della porta COM sia corretto. Per quanto
riguarda la velocita di comunicazione, lasciare per ora AUTODETECT.
Per un collegamento Ethernet invece e necessario selezionare TCP/IP e specificare il TCP/IP Host & Port con il suo indirizzo IP e il
numero della porta a 5001. Per configurare il QMOVE con uno specifico indirizzo IP si deve usare una delle utility installate nel
QWorkbench: QConfigurator-1 oppure QConfigurator-2.

Ora fare un doppio click sulla risorsa da usare per il collegamento e il messaggio No connection sulla barra in basso dovrebbe
cambiare in Connected with... sequito dal codice del modello hardware utilizzato.

2.3 Trasferimento del progetto compilato nella CPU (Download)

In questo momento si € pronti per trasferire il progetto compilato nella CPU. Selezionare:
¢ Project - Download

e il progetto verra trasferito. Durante il trasferimento una finestra informa sullo stato del trasferimento.

2.4 Monitoraggio del funzionamento

Il sistema ora & pronto per mettere in esecuzione I'applicativo appena scaricato. Seleziona:
e Monitor - CPU

Appare la finestra
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si noti che la finestra presenta il messaggio Mode READY.
Selezionando il comando

e Debug - Run,

|"applicativo scaricato viene messo in esecuzione; lo stato della CPU diventa RUN. Cliccare ora sul tasto e inserire un
nuovo Watches Panel con il nome Counter Monitor (oppure un nome a scelta del programmatore). Nella prima riga del Watches
Panel inserire il nome dell'unica variabile del nostro progetto count.

ounder Monibor - Watches Panel )

Type | Heference | Vsl
€ oo o

et 1
Lrscogrissd Reference

Quando la CPU & in RUN vedremo il valore della variabile che si incrementa.
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3. Introduzione alla programmazione

3.1 Dichiarazioni

Le dichiarazioni possibili in un progetto per QMOVE possono essere le seguenti:

¢ dichiarazione dei simboli;
¢ dichiarazione dei device;
¢ dichiarazione del hardware utilizzato.

Queste dichiarazioni possono avvenire

¢ nella unit di configurazione, oppure
¢ nelle altre unit che compongono il progetto e che contengono anche il codice operativo del progetto.

| simboli sono i nomi assegnati alle variabili, array, datagroup, costanti, input o output. Per distinguere tra loro le varie
dichiarazioni si utilizzano delle parole chiavi poste prima di ogni gruppo di dichiarazioni. Le parole chiavi sono:

e CONST

e SYSTEM

e GLOBAL

¢ ARRSYS

¢ ARRGBL

¢ TIMER

e INPUT

e OUTPUT

¢ INTDEVICE

e DATAGROUP (solo nella unit di configurazione)
¢ BUS (solo nella unit di configurazione)

e REFERENCES (solo nella unit di configurazione)

3.1.1 Unit di configurazione

La unit di configurazione € una componente di un progetto per QMOVE; c'é un'unica unit di configurazione in un progetto.
La unit di configurazione serve come contenitore di dichiarazioni di alcune variabili e di alcune le costanti utilizzate
nell’applicativo; inoltre viene anche definita la composizione hardware del sistema QMOVE adottato, specificando il tipo di
scheda CPU e il modello delle schede presenti.

Le variabili, array, datagroup, device e costanti dichiarati nella unit di configurazione sono disponibili per tutto il progetto.
Possono essere visibili (e quindi leggibili e scrivibili) da tutte le altre unit che compongono il progetto.

3.1.2 Unit operative

Le altre unit che compongono un progetto per QMOVE possono essere piu di una e hanno lo scopo di contenere il codice
operativo che determina la logica di funzionamento del progetto stesso. Inoltre all'inizio di queste unit € possibile fare lo stesso
tipo di dichiarazioni che si possono fare nella unit di configurazione (tranne la dichiarazione della composizione dell'hardware e
la dichiarazione degli ingressi e uscite digitali).

Le variabili, array, datagroup dichiarate nelle unit operative possono essere dotate di una proprieta di accessibilita aggiuntiva.
Normalmente quando si dichiara una variabile in una unit operativa essa pu0 essere utilizzata solamente in quella unit. In fase
di dichiarazione ¢ possibile, pero, assegnare ad essa una proprieta aggiuntiva:

¢ IN, il simbolo & accessibile in scrittura/lettura dalle altre unit, mentre & accessibile solamente in lettura
dalla unit che dichiara quel simbolo;

e OUT, il quel simbolo & accessibile in scrittura/lettura dalla unit dichiarante, mentre le altre unit possono
solamente usarlo in lettura

¢ INOUT, il simbolo & accessibile in scrittura/lettura sia dalla unit dichiarante che da tutte le altre unit.

3.2 Tipi di variabili

In seguito descriveremo tutte le informazioni che & necessario conoscere per poter dichiarare le variabili.
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Nella descrizione della sintassi le parti tra <...> sono obbligatorie. Le parti tra [...] sono opzionali, mentre le parti separate da
“/” sono da considerarsi “usare uno di questi”.

Il carattere punto e virgola (“;”) ha lo scopo di identificare una riga di commento. Tutto il testo inserito dopo questo carattere
non verra considerato. Il carattere punto e virgola vale solo per la linea in cui e inserito.

QCL prevede cinque tipi principali di dato:
3.2.1 Flag

Il dato di tipo FLAG e utilizzato per la definizione di variabili booleane che hanno un range di valori interi compresotra 0 e 1.
L'occupazione della memoria da parte delle variabili di questo tipo dipende dal loro numero.
La sintassi per la definizione di una variabile di tipo FLAG ¢ la seguente:

<variable name> F [OUT/IN/INOUT] [;comment]

3.2.2 Byte

Il dato di tipo BYTE & utilizzato per la definizione di variabili che hanno un range di valori interi compreso tra -128 e +127; ogni
variabile occupa un byte di memoria.
La sintassi per la definizione di una variabile BYTE & la seguente:

<variable name> B [OUT/IN/INOUT] [;comment]

3.2.3 Word

Il dato di tipo WORD & utilizzato per la definizione di variabili che hanno un range di valori interi compreso tra -32768 e
+32767; ogni variabile occupa due byte di memoria.
La sintassi per la definizione di una variabile WORD & la seguente:

<variable name> W [OUT/IN/INOUT] [;comment]

3.2.4 Long

Il dato di tipo LONG & utilizzato per la definizione di variabili che hanno un range di valori interi compreso tra -2147483648 e
+2147483647; ogni variabile occupa quattro byte di memoria. La sintassi per la definizione di una variabile LONG ¢ la
seguente:

<variable name> L [OUT/IN/INOUT] [;comment]

3.2.5 Single

Il dato di tipo SINGLE ¢ un valore a virgola mobile come definito dalla specifica IEEE 754 single precision.
La sintassi per la definizione di una variabile SINGLE ¢ la seguente:

<variable name> S [OUT/IN/INOUT] [;comment]

3.2.6 Double

Il dato di tipo DOUBLE & un valore a virgola mobile come definito dalla specifica IEEE 754 double precision.
La sintassi per la definizione di una variabile DOUBLE ¢ la seguente:

<variable name> D [OUT/IN/INOUT] [;comment]

3.2.7 Tabella riassuntiva dei tipi di variabili utilizzabili

Assegnando ad una variabile un valore esterno al range consentito si verifica la condizione di overflow.

Tipo dato | Codice | Spazio occupato memoria (Bit) | Intervallo

FLAG F 1 0+1

BYTE B 8 -128 + 127

WORD ' 16 -32768 + 32767

LONG L 32 -2147483648 + 2147483647

SINGLE S 32 Vedi specifica IEEE 754 single precision
DOUBLE | D 64 Vedi specifica IEEE 754 double precision
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3.3 Gli Identificatori

Gli identificatori sono dei nomi tramite i quali & possibile fare dei riferimenti ad oggetti o ad etichette. Ogni identificatore &
formato da uno o pil caratteri alfanumerici tenendo presente che il primo deve essere una lettera. | caratteri alfanumerici
possono essere riassunti in:

- dalla “A” alla “Z"

- dalla “a" alla “z”

-da“0"a"9"”

3.3.1 1 nomi

| nomi vengono usati per agevolare I'identificazione di un oggetto all'interno del sistema QMOVE. Per oggetto si intende
qualsiasi entita gestibile a livello di linguaggio e provvista di caratteristiche fisiche proprie come ad esempio: variabili, ingressi,
uscite e devices. In Qview 6.0 i nomi sono limitati ad una lunghezza massima di 64 caratteri.

3.4 Le costanti

Una costante € un carattere o una stringa di caratteri utilizzabile come valore in un progetto. Le costanti vengono dichiarate in
seguito alla parola chiave CONST. Viene riportata la sintassi per la definizione di costanti:

CONST
<nome costante> <valore> [OUT] [;comment]
dove:
CONST Parola chiave che indica la definizione delle costanti.
<nome costante> | Nome della costante.
<valore> valore associato alla costante.
[0UT] Si pud usare in una dichiarazione all'interno di una unit operativa quando si vuole rendere accessibile in lettura la costante
anche alle altre unit operative.
[;comment] Il commento non & obbligatorio ma consigliato per una miglior lettura del software

Un esempio di dichiarazione di alcune costanti é:

CONST
TM SECOND 1000 OUT ;These are the number of milliseconds in a second.
DIM ARRAY 7 OUT ;Used as array dimension.
DIM PROG 10 ;Used as number of recipe.
DIM STEP 5 ;Used as number of step for each recipe.

3.5 Le variabili SYSTEM

| Le variabili SYSTEM mantengono il loro valore anche allo spegnimento del sistema. |

Con il nome SYSTEM vengono raggruppate tutte le variabili ritentive; possono essere di tipo FLAG, BYTE, WORD, LONG o
SINGLE. Devono essere poste in seguito alla parola chiave SYSTEM. La sintassi per la definizione di variabili SYSTEM.

SYSTEM
<nome variabile> <F/B/W/L/S> [OUT/IN/INOUT] [;comment]
dove:
SYSTEM Parola chiave che indica la definizione di variabili SYSTEM.
<nome variabile> | Nome della variabile SYSTEM.
<F/B/W/L/S> Tipo della variabile e puo essere.
[OUT/IN/INOUT] Tipo di accessibilita.
[;comment] Il commento & consigliato per una miglior lettura del software.
Esempio:
SYSTEM
count L ;This is used as a counter.
sbSeconds B OQUT ;Seconds
sbMinutes B OUT ;Minutes
swHours W ;Hours

3.6 Le variabili GLOBAL

| Le variabili GLOBAL hanno la caratteristica di venire azzerate ad ogni accensione del sistema |

Con il nome GLOBAL vengono raggruppate tutte le variabili non ritentive; possono essere di tipo FLAG, BYTE, WORD, LONG e
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SINGLE. Vengono dichiarate in seguito alla parola chiave GLOBAL. Viene riportata la sintassi per la definizione di variabili
GLOBAL.

GLOBAL
<nome variabile> <F/B/W/L/S> [OUT/IN/INOUT] [;comment]
dove:
GLOBAL Parola chiave che indica per la definizione di variabili GLOBAL.
<nome variabile> | Nome della variabile GLOBAL.
<F/B/W/L/S> Tipo della variabile.
[OUT/IN/INOUT] Tipo di accessibilita.
[;comment] Il commento & consigliato per una miglior lettura del software.
Esempio:
GLOBAL i i
gfMyFlag F OUT ;Non retentive flag variable
gbYourByte B IN ;Non retentive byte variable
gwHisWord W  INOUT ;Non retentive word variable
glYourLong L ;Non retentive long_variable, .
gsTheirSingle S OUT  ;Non retentive single precision variable

3.7 Le variabili ARRAY SYSTEM

Una variabile Array System & un insieme di variabili ritentive dello stesso tipo. Esse hanno la stessa dimensione ed & possibile
accedere ad esse tramite un nome comune e riferendosi ad uno specifico elemento tramite un indice. Non sono previsti array di
variabili tipo FLAG.

Come le SYSTEM sono variabili ritentive e devono essere dichiarate di seguito alla parola chiave ARRSYS.

Viene riportata la sintassi per la definizione di variabili ARRAY SYSTEM.

ARRSYS
<nome variabile> <B/W/L/S> <numero_elementi> [OUT/IN/INOUT] [;comment]

dove:

GLOBAL Parola chiave che per la definizione di variabili ARRAY SYSTEM.

<nome variabile> Nome della variabile ARRAY SYSTEM.

<B/W/L/S> Tipo della variabile e puo essere

<numero_elementi> | Numero di elementi che compongono la variabile.

[OUT/IN/INOUT] Tipo di accessibilita.

[;comment] Il commento & consigliato per una miglior lettura del software.

Il numero massimo di elementi consentiti in un array & di 65535. Non si possono indicare dimensioni negative o dimensioni con
parte decimale. Come dimensione dell’array € possibile usare delle costanti gia definite nella sezione CONST; se questa avesse
valore decimale verra troncato: ad esempio il valore 200.34 viene forzato a 200.

Esempio:

ARRSYS
asbMyArray B 10 INOUT ;Array system declaration of 10 bytes in size, .
aslYourArray L DIM ARRAY 1IN ;Array system declaration of DIM ARRAY bytes in size.

Si osservi che nel secondo array si € usata una costante per la dichiarazione della dimensione.

3.8 Le variabili ARRAY GLOBAL

Una variabile Array Global & un insieme di variabili non ritentive dello stesso tipo. Esse hanno la stessa dimensione ed
possibile accedere ad esse tramite un nome comune, riferendosi ad uno specifico elemento tramite un indice. Non sono previsti
array di variabili tipo FLAG.

Come le GLOBAL sono variabili non ritentive e devono essere dichiarate di seqguito alla parola chiave “ARRGBL".

Viene riportata la sintassi per la definizione di variabili ARRAY GLOBAL:

ARRGBL
<nome variabile> <B/W/L/S> <numero elementi> [OUT/IN/INOUT] [;comment]
dove:
ARRGBL Parola chiave per la definizione di variabili ARRAY GLOBAL.
<nome variabile> Nome della variabile ARRAY GLOBAL.
<B/W/L/S> Tipo della variabile e puo essere.
<numero_elementi> | Numero di elementi che compongono la variabile.
[OUT/IN/INOUT] Tipo di accessibilita.

15/94



QVIEW 6.0

| [;comment] Il commento & consigliato per una miglior lettura del software. |

Esempio:

ARRGBL
arwMyArray W 15 OUT ;Array global declaration of byte of 15 dimension.

3.9 Le variabili TIMER

Sono variabili utilizzate per realizzare temporizzazioni alle quali pud essere assegnato un valore intero (espresso in ms) che
rappresenta il tempo che deve trascorrere (dal momento dell’assegnazione); in lettura e disponibile lo stato di
“temporizzazione terminata” (1) o “temporizzazione in corso” (0).

Le variabili timer vengono dichiarate in seguito alla parola chiave “TIMER”".

La sintassi per la definizione di variabili TIMER &:

TIMER
<timer name> [OUT/IN/INOUT] [;comments]
dove:
TIMER Parola chiave per la definizione di variabili TIMER.

<timer name> | Nome della variabile TIMER.
[OUT/IN/INOUT] | Tipo di accessibilita.
[;comment] Il commento e consigliato per una miglior lettura del software.

Esempio:

TIMER
tTimerl INOUT ;First timer.
tTimer2 ouT ;Second timer.
tSeconds OUT ;3rd timer.
tDelay INOUT ;4th timer.

Quando la variabile timer si trova a sinistra dell’assegnazione si definisce il caricamento di un valore sul timer (valore espresso
in millisecondi):

tMyTimer = 1000 ;Set timer tMyTimer to 1 second.

Quando la variabile timer si trova a destra dell’assegnazione o all’interno di una espressione ne viene letto lo stato (0 =
Temporizzazione in corso, 1 = Temporizzazione terminata):

gfIsTimerEnd = tMyTimer ;Assign to gfIsTimerEnd variable the timer state.
oppure

IF(tM¥Timer) ;I timer tMyTimer has passed exec the code
;Put here the code

E, inoltre, possibile leggere il valore del tempo rimanente prima dello scadere del timer (il valore restituito & espresso in
millisecondi):

< Timer Name >.remain
Esempio:

glRemainTime = tMyTimer.remain

3.10 Le variabili INPUT ed OUTPUT

Sono tutte le variabili che fanno riferimento ad ingressi od uscite digitali. La loro dichiarazione deve essere posta in seguito alle
parole chiave INPUT per gli ingressi o OUTPUT per le uscite.

| Gli ingressi e uscite digitali possono essere dichiarati solamente nella unit di configurazione. |

La sintassi per la definizione di variabili INPUT ed OUTPUT é&:

INPUT | i
<variable name> <F/B/W> <io address>
OUTPUT .
<variable name> <F/B/W> <io address>

| Gli 1/0 address sono disponibili sulle schede tecniche hardware delle schede utilizzate.

dove:
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INPUT Parola chiave per la definizione di variabili INPUT.

OUTPUT Parola chiave per la definizione di variabili OUTPUT.

<variable name> | Nome della variabile, cioé il simbolo associato all'ingresso o uscita.

<F/B/W> Tipo della variabile
Indirizzo dell'INPUT o OUTPUT cosi composto:

<io address> Slot number.name: Slot number & il numero dello slot nel quale € posta la scheda con la risorsa hardware.
name: & il nome che fa riferimento all’indirizzo fisico dell’'l/O (definito nei riferimenti hardware).

Un’applicazione interessante degli ingressi e delle uscite digitali € quello del raggruppamento degli stessi in un unico
identificatore. Questo identificatore € analogo ad una variabile di otto o sedici bit dove ogni ingresso o uscita digitale
rappresenta un bit.

Esempio:
INPUT

ibInput B 3.INPB ;8 digital input grupped in a single byte
OUTPUT o ) )

obOutput B 3.0UTB ;8 digital output grupped in a single byte

Se si dispone di schede con piu di otto ingressi o uscite digitali Esempio:

INPUT
ibInputl B 3.INPB1  ;First 8 digital_ input grupped in a byte (1+8).
ibInput2 B 3.INPB2 ;Second 8 dlgltal_lnfut grupped in a byte (9+16).
iwInput W 3.INPW ;A word of 16 digital input grupped in"a word (1+16).

OUTPUT
obQutputl B 3.0UTB1 ;First 8 digital_ output grupped in a byte 8 (1+8).
obQutput2 B 3.0UTB2 ;Second 8 dlgltalloutput grupped in a byte 8 (9+16).
owOutput B 3.0UTW ;A word of 16 digital output grupped in"a word (1+16).

3.11 Le variabili DATAGROUP

Le variabili Datagroup sono una particolare struttura di dati, memorizzate in una zona ritentiva. Esse vengono dichiarate nella
unit di configurazione e sono idonee per rappresentare un archivio di ricette.
Le variabili Datagroup contengono due tipologie di variabili:

3.11.1 Variabili Statiche

DATAGROUP
<DataGroup Name>
DATAPROGRAM .
<number of_ recipes> .
;Static variables declaration
<variable name> <F/B/W/L/S>
<variable name> <F/B/W/L/S>
<variable name> <F/B/W/L/S>

Le variabili statiche risiedono nel sottosettore di DATAGROUP nominato come DATAPROGRAM. Il primo valore di questo settore
€ un numero o una costante intera, e indica il numero di ricette dell'archivio. Le variabili statiche sono da considerarsi come
contenitori di un determinato valore per ogni ricetta, e sono accessibili come un array, dove l'indice & il numero di ricetta
desiderata. Esempio:

DATAGROUP
ame
DAIAPROGRAM
;Static variables declaration
Variablel L
Variable2 S
Variable3 F

Per far riferimento alla variabile Variable3 della ricetta 5, viene usato il codice:
Variable3[5]

Possiamo immaginare la struttura della memoria di una variabile DATAGROUP, nel nostro esempio con variabili statiche, come
la seguente tabella:

Variablel | Variable2 | Variable3

Ricetta 1
Ricetta 2
Ricetta 3

Ricetta 100
3.11.2 Variabili Indicizzate

DATAGROUP
<DataGroup Name>
DATAPROGRAM
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<number of recipes>
TEP
<number of steps> .
;Indexed variables declaration
<variable name> <F/B/W/L/S>

<variable name> <F/B/W/L/S>
<variable name> <F/B/W/L/S>

Le variabili indicizzate risiedono nel sottosettore di DATAGROUP nominato come STEP. La loro funzione € quella di introdurre
per ogni ricetta, il concetto di passo. Il primo valore di questo settore € un numero o una costante intera, e indica il numero di
passi per ogni ricetta dell'archivio. Le variabili indicizzate sono da considerarsi come contenitori di una lista di valori per ogni
ricetta, e sono accessibili come un array a 2 dimensioni, dove il primo valore € il numero di ricetta, il secondo il passo
desiserato. Esempio:

DATAGROUP
ame
DATAPROGRAM
;Static variables declaration
Variablel L
Variable2 S
Variable3 F
STEP

Variable4
Variable5 B

; Indexed variableswdeclaration

Per far riferimento alla variabile Variable4 della ricetta 5 al passo 9, viene usato il codice:
Variable4[5, 9]

Possiamo immaginare la struttura della memoria di una variabile DATAGROUP, nel nostro esempio con variabili statiche e
indicizzate, come la seguente tabella:

Variablel | Variable2 | Variable3 | Variable4 | Variable5

Ricetta 1
Ricetta 2
Ricetta 3

Ricetta 100

Altre informazioni:

¢ In un DATAGROUP tutte le variabili, sia statiche che indicizzate, sono ritentive (mantengono il valore allo
spegnimento).

e Le variabili Datagroup possono essere piu di una, in questo caso & necessario inserire pil parole chiave
DATAGROUP.

¢ La sottosezione DATAPROGRAM & obbligatoria, mentre quella STEP € opzionale.

e || numero massimo di ricette impostabile € 65534.

¢ [l numero massimo di passi impostabile € 65534.

¢ Rispetto ad un comune array, le variabili statiche possono supportare anche un dato di dimensione Flag

(F).
3.12 Sezione BUS

La sezione BUS nell’unita di configurazione ¢ indispensabile per dichiarare quale modello hardware di QMOVE il programmatore
ha a disposizione.

In base al modello hardware dichiarato & possibile anche avere a disposizione le sue risorse hardware come per esempio il
numero di ingressi e uscite digitali, il numero di ingressi e di uscite analogiche oppure il numero di ingressi di conteggio. Il
QMOVE puo inoltre essere dotato anche di altre risorse come interfacce seriali o lettori di memoria removibile.

La dichiarazione da inserire nella sezione BUS si suddivide in slot. Nello slot 1 si indica quale & la CPU utilizzata mentre negli
slot successivi servono per dichiarare quali schede elettroniche sono installate nel modello. Ogni scheda ¢ individuata da una
parola chiave che ne identifica tipologia di hardware. Le parole chiavi sono reperibili nei manuali installazione e manutenzione
dell’hardware utilizzato.

La sintassi da utilizzare &:

BUS

1 <ID CPU> <Fw>
2 <ID CARD>
3 <ID CARD>
4 <ID_CARD>
Esempio:
BUS
1 1P51F 30 ;QMOVE J1-P51F with firmware 30
2 . . ;No card is installed in this slot
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3 1MG8F . ;This card has 32 digital input, 32 digital output, 6 analog output, ecc.
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4. Visibilita delle variabili

L'argomento relativo alla visibilita dei simboli dichiarati all'interno del progetto € molto importante. Vale la pena di riprenderlo
con cura in questo capitolo dedicato ad esso.
Come abbiamo detto in precedenza, € possibile dichiarare i seguenti gruppi

CONST

INTDEVICE

sia nella unit di configurazione che nelle altre unit che compongono il progetto. Gli altri gruppi di dichiarazioni

BUS
REFERENCES

Possono essere presenti solamente nella unit di configurazione.

| Come vedete € apparsa la parola chiave REFERENCES che merita una spiegazione approfondita alla fine di questo capitolo. |

Nella seguente figura & rappresentato schematicamente dove & possibile trovare i vari gruppi di dichiarazione in un progetto.

Configurator Unitl Unit2
/ r—

CONST
SYSTEM
GLOBAL
ARRSYS
ARRGBL
TIMER
INPUT
OUTPUT
INTDEVICE

4.1 Variabili di configurazione

| simboli dichiarati nella unit di configurazione hanno una visibilita estesa a tutte le unit del progetto. Facciamo I'esempio di
dichiarare una variabile del gruppo SYSTEM:

SYSTEM
ConfigurationVariable L ;This variable is declared in the configuration unit

Questa variabile potra essere utilizzata in qualsiasi altra unit presente nel progetto sia per assegnare ad essa un valore
(scrittura) sia per essere usata come valore all'interno di una espressione (lettura).

ConfigurationVariable =5 . ;Assign the value 5 to the variable .
UnitlVariable = ConfigurationVariable * 2 ;Assign twice variable value to another variable

In realta la notazione completa per riferirsi alla variabile ConfigurationVariable € la seguente:

APPLICATION.ConfigurationVariable

La radice APPLICATION. puo essere omessa e spiegheremo in seguito quando usarla.
4.2 Variabili locali

I simboli che vengono dichiarati all'interno delle unit che contengono il codice operativo, prima della parola chiave BEGIN,
hanno una visibilita diversa. Per esempio la seguente variabile:
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GLOBAL
BEé%ﬁal_variable W ;This variable is declared in a unit
. ;Here are the code lines

e visibile solamente all'interno della unit in cui viene dichiarata. Nessuna altra unit potra accedere a questa variabile né in
lettura né in scrittura. Essa & considerata una variabile locale nel senso che viene dichiarata per scopi che si esauriscono nella
stessa unit. E' possibile che un'altra unit contenga una dichiarazione di una variabile con lo stesso nome. Non sara possibile
infatti incorrere in equivoci perché quando si usa il simbolo local_variable in una unit, € chiaro che ci si riferisce sempre alla
variabile locale e non a quella di un'altra unit.

4.3 Variabili IN/OUT/INOUT

Aggiungendo dei particolari attributi alla dichiarazione di una variabile, & possibile creare un'interfaccia verso I'esterno della
unit in cui & dichiarata. Questi attributi sono

e IN
e OUT
e INOUT

Se per esempio ampliamo il precedente esempio:

GLOBAL
InputVariable L IN ;This variable is like an input
QutputVariable L OUT ;This variable is like an output
InOutVariable L INOUT ;This variable is both an input and an output
Eé%calivariable W ;This variable is declared in a unit

BEGIN
. ;Here are the lines code

otteniamo una interfaccia della unit verso le altre unit.

4.3.1IN

La variabile InputVariable viene vista dalla unit come un input e quindi essa non potra essere modificata internamente ma
solamente utilizzata per il suo valore. In pratica & una variabile in sola lettura per la unit che la dichiara.

Unit2 Unitl
f,’ . rf' "
“ GLOBAL
InputVariable L IN
BEGIN Write Read
MAIN BEGIN
Unitl InputVariable = 1 MAIN:
IF InputVariable
WAIT 1 :
JUMP MAIN ENDIF
END WAIT 1
JUMP MAIN
END

Come si vede dalla figura, le altre unit (Unit2) possono accedere ad essa se specificano quale ¢ la unit a cui la variabile
appartiene:

Unitl.InputVariable =1

In questo modo ci potranno essere unit che hanno la stessa o le stesse variabili con proprieta IN. Non potranno esserci equivoci
perché ogni variabile appartiene a unit con nomi differenti.

4.3.2 OUT

La variabile OutputVariable & un output per la unit che la dichiara. Essa quindi € il risultato di una elaborazione interna alla unit
ed & usata per fornire alle altre unit questo risultato. La variabile dichiarata con questa proprieta ¢ in sola lettura per tutte le
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altre unit.

Unit2 Unitl

il

GLOBAL
OutputVariable L OUT

//'

{

BEGIN
MAIN
IF Unitl.OutputVariable

Read Write

BEGIN
MAIN:
ENDIF

OutputVariable = 1

WAIT 1 =

JUMP MAIN WAIT 1

END JUMP MAIN
END

Come si vede dalla figura, le altre unit (Unit2) possono utilizzare il valore della variabile OutputVariable solo se specificano
prima il nome della unit a cui la variabile appartiene:

IF Unitl.OutputVariable
ENDIF

4.3.3 INOUT

La variabile InOutVariable & sia un IN che un OUT. Tale variabile puo essere modificata sia dalla unit che la dichiara sia dalle
altre unit.

Unit2 Unitl

/"

{

/ GLOBAL
InOutVariable L INOUT

Read

BEGIN
MAIN
IF Unitl.InOutVariable EQ 0 E"Ii?hllm

Unitl. InOutVariable =1 Read

IF InOutVariable

EI'\'J.[.}IF InDutVariable = 0

WAIT 1 Write
ENDIF
JUMP MAIN ;
Write
END WAIT 1

JUMP MAIN
END

Anche in questo caso le altre unit (Unit2) possono utilizzare la variabile della Unitl specificando prima del suo nome anche il
nome della unit a cui appartiene:

IF Unitl.OutputVariable EQ 0
Unitl.OutputVariable = 1

ENDIF
4.4 APPLICATION

Abbiamo gia detto che la notazione completa per identificare le variabili dichiarate nella unit di configurazione &

APPLICATION.<variable name>

E' necessario usare la radice APPLICATION. prima del nome della variabile quando ci possono essere fonti di equivoco. Infatti se
venisse dichiarata la variabile HomePosition nella unit di configurazione e un'altra variabile con lo stesso nome in Unit1, cio
sarebbe fonte di equivoco.

Per questo motivo quindi si deve usare la notazione

APPLICATION.HomePosition
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Unitl.HomePosition

a seconda di chi ci si riferisce.
5. REFERENCE

Un diverso attributo che puo essere assegnato ad un simbolo al momento della dichiarazione & il REFERENCE. In questo caso il
simbolo che viene dichiarato come REFERENCE & semplicemente un riferimento ad una variabile dichiarata in un altro punto
(tipicamente nella unit di configurazione). La dichiarazione di questi speciali simboli sara composta di due fasi

1. dichiarazione nella unit dove viene utilizzata;
2. dichiarazione nella unit di configurazione (nella sezione REFERENCES) di quale variabile & il riferimento.

Per esempio:
Nella Unitl

GLOBAL
MachineState B REFERENCE

Nella unit di configurazione

GLOBAL

GeneralState B

REFERENCES

Unitl.MachineState = GeneralState

La variabile GeneralState & un simbolo generico che viene associato alla variabile dichiarata localmente in Unitl e chiamata
MachineState. | riferimenti devono essere sempre stabiliti tra simboli dello stesso tipo. E' possibile creare dei riferimenti per
tutti i tipi di dichiarazioni (SYSTEM, GLOBAL, ARRSYS, ARRGBL, INPUT, OUTPUT, INTDEVICE, TIMER).

I " Ladichiarazione di INTDEVICE, INPUT, OUTPUT puo avvenire solamente
{ " . come REFERENCE.

6. COSTANTI

Anche le costanti possono essere dichiarate nelle unit che contengono il codice operativo. Se la dichiarazione avviene in questo
modo nella Unitl per esempio:

CONST
MAX_PROGRAM NUMBER 100 ;local constant
BEGIN

la costante MAX_PROGRAM_NUMBER potra solamente essere usata internamente alla unit che la dichiara. Se invece la
dichiarazione € come la seguente:

CONST
MAX_PROGRAM NUMBER 100 OUT ;Output constant
BEGIN

allora la costante MAX_PROGRAM_NUMBER sara visibile anche dalle altre unit. Vale sempre e comunque la regola che le altre
unit potranno accedere a questa costante in questo modo:

Unitl.MAX_PROGRAM_NUMBER
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7. Istruzioni QCL

I QCL (QEM Control Language) € un linguaggio nato appositamente per la programmazione del sistema QMOVE. Le
caratteristiche principali del QCL sono la semplicita (poche ma potenti istruzioni), la facilita d'uso (somiglianza con il linguaggio
BASIC) e I'orientamento verso I'automazione industriale grazie alle istruzioni appositamente studiate per il controllo assi.

7.1 Gli operatori del QCL

Nel linguaggio QCL vengono messi a disposizione tutti gli operatori elementari per la manipolazione dei dati.
7.1.1 Operatore di assegnamento

L'operatore di assegnamento puo essere utilizzato all'interno di una qualunque espressione e puo agire su tutte le variabili, sia
elementari che appartenenti a DataGroup o a parametri Device. La forma generica di un'istruzione di assegnamento & la
seguente:

<variable name> = <expression>

Se la dimensione della variabile variable name ¢ inferiore alla dimensione del risultato dell'espressione il valore viene troncato,
secondo le regole della conversione di tipo (vedi appendice dedicata).

7.1.2 Operatori aritmetici

Gli operatori aritmetici sono

e somma (+),

sottrazione (-),
moltiplicazione (*),
divisione (/),

resto della divisione (%).

Questi operatori agiscono su tutti i tipi di dato e sulle loro combinazioni (compresi i bit).
Esempio:

sbVar0l = slVar02 + swVar03
slVarxy = %IVarA * glvarB
s101 = ss@ % ss0

7.1.3 Operatori logici

Gli operatori logici (AND, OR e NOT) possono agire su tutte le variabili tranne quelle a singola precisione. La loro funzione &
riassunta dalla seguente tabella.

Negli esempi il valore 1 indica semplicemente che la variabile é diversa da 0. |

ab|aANDb |aORb | NOTa
00 0 0 1
01 0 1 1
10 0 1 0
11 1 1 0
Esempi

Bit0l = 81B1t02 AND gfBit03
BitA = NOT

7.1.4 Operatori binari

Gli operatori binari

ANDB,
e ORB,

NOTB,
XORB

24/94



QVIEW 6.0

agiscono su tutti i tipi di variabili compresi i SINGLE (previa conversione automatica in intero). Questi operatori realizzano la
stessa tabella di verita che regola le equivalenti operazioni logiche, con la differenza che agiscono sui singoli bit.

(@) | (b)y | (@), | (b), | aANDBb | a ORBb | NOTB a | a XORB b

3 2 | 011010 010 011 100 001
7 5 111 | 101 101 111 000 010
Esempio

swVar0l = gwVar02 ANDB gwVar03

7.1.5 Operatori relazionali

Permettono di valutare le relazioni che intercorrono tra i valori. Il linguaggio QCL definisce cinque operatori relazionali.

EQ | uguale a (equal)

NEQ | non uguale a (not equal)

LT minore di (lower than)

LE minore o uguale a (lower equal)

GT | maggiore di (greater than)

GE | maggiore o uguale a (greater equal)

Esempio

gfBit@1 = glCont GE glAsse01

7.1.6 Gli operatori di livello di precedenza

Sono le parentesi rotonde “()” che permettono di modificare il livello di precedenza degli operatori sopradescritti.
Esempio AA = [(A + B)/C] - (D X E)

gwVarAA = ((gwVarA + gwVarB) / glvarC) - (swVarD * glVarE)

7.1.7 Livelli di priorita degli operatori del QCL

Il livello di priorita degli operatori QCL ricalca quello di tutti i linguaggi di programmazione. Le priorita sono le seguenti:

Priorita massima

()
Funzioni matematiche e
Funzioni trigonometriche

NEG NOT NOTB
* [ %
+ -
LT GT LE GE
EQ
AND ANDB
OR ORB XORB

Priorita minima

7.2 Istruzioni e strutture per il controllo del flusso

Sono tutte quelle istruzioni che permettono di modificare il flusso di esecuzione.
7.2.1 IF /| ELSE / ENDIF

E la tipica istruzione condizionale; se la <expression> & vera, valore booleano 1, viene eseguito il blocco istruzioni

~altrimenti viene eseguito il blocco istruzioni <code lines 2>. Un blocco istruzioni pud essere costituito da un
insieme_di istruzioni ma anche da un'istruzione sola; inoltre la sezione ELSE &
opzionale. La sintassi e:
<code QCL> .
IF <expression>
<code lines 1>
[ELSE
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<code lines 2>]

ENDIF
Esempio:
MAIN:
IF tTime ;If timer has expired
tTime = TM SECOND reload the timer and
ENS%gnt = count + 1 iincrease by 1 the variable count

WAIT 1
JUMP MAIN
END

Esempio di ciclo IF nidificato.
Modifichiamo I'esempio appena introdotto nel modo seguente:

MAIN:
IF tSeconds ;If the timer has expired
tSeconds = TM_SECONDO ireload the timer.
IF sbSeconds LT 59 If the sbSeconds variable is less than 59
sbSeconds = sbSeconds + 1 ;increase the seconds counter
. ielse (if the seconds are greater than 59)
sbSecondi = 0 ;reset the seconds
IF sbMinutes LT 59 :If the sbMinutes variable is less than 59
sbMinutes = sbMinutes + 1 ;increase the minutes counter
LSE . . ielse (if the minutes are greater than 59)
sbMinuti = 0 ;reset the minutes
IF swHours LT 167 If the swHours variable is less than 167
swHours = swHours + 1 ;increase the hours
LSE ielse (if the hours is greater than 167)
ENgyEours =0 ;reset the hours, because a week has passed.
ENDIF
ENDIF
ENDIF
WAIT 1

JUMP MAIN
END

Abbiamo realizzato cosi un orologio di sistema con tre variabili system: una per i secondi, una per i minuti e una per le ore. Si &
utilizzata una variabile di tipo Byte per i secondi e per i minuti dato che il valore che esse assumono non esce mai dal range
[-128, 127], mentre per la variabile swHours si & utilizzato una variabile di tipo Word dato che pu0 arrivare fino al valore 167,
all'interno del range [-32768, 327671, che & il numero di ore in una settimana.

7.2.2 FOR-NEXT

E un ciclo iterativo che serve normalmente per eseguire un certo numero di volte una o un blocco di istruzioni. E possibile
uscire dal ciclo FOR-NEXT prima che diventi falsa la condizione di ciclo tramite l'istruzione BREAK; quando quest'ultima viene
incontrata viene eseguito un salto alla prima istruzione successiva al NEXT. La sintassi &:

FOR (<initialization>, <test>, <increment>)
E)<(Tcode lines >

dove:

<initialization> | e una espressione eseguita all'avvio del ciclo e quindi una sola volta
<test> & una espressione condizionale che, se falsa, determina la fine del ciclo FOR
<increment> € un valore numerico che viene sommato all'indice al termine di ogni esecuzione del < code lines >

Esempio:
AIN
FOR(ngourByte =1, ngourB te LE 10, 1) ;For gbYourByte from 1 to 10
aer¥Array[$bYourByte] ow(3, ngourByte) the element aeryArray[ﬁbYourByte gets_the value 3”gbYourByte,
dswStat2[gbYourB te] = ,a551gn the value' 1l e static variable
e ddbDlnl [gbYourByte,1] = 2 ;assign the value 2 to the indexed variable if the 1st step.
WAIT 1

JUMP MAIN
END
Con il ciclo FOR-NEXT visto si riempie I'array global arwMyArray delle prime 10 potenze di 3.

7.2.3 WHILE-ENDWHILE

E un ciclo iterativo che serve per eseguire una o un blocco di istruzioni finché una condizione si verifica.
E possibile uscire dal ciclo WHILE-ENDWHILE prima che diventi falsa la condizione di ciclo tramite I'istruzione BREAK; quando
quest'ultima viene incontrata viene eseguito un salto alla prima istruzione successiva al ENDWHILE. La sintassi €:

WHILE (<condition>)
< code lines >
ENDWHILE

dove:
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€ una espressione condizionale che deve dare un risultato booleano. Quando la condizione e vera vengono eseguite

<condition> ; . - N . . : A
continuamente le < code lines >. Quando la condizione ¢ falsa si passa ad eseguire il codice successivo a ENDWHILE.

Esempio:

Questi due cicli hanno lo scopo di poter impostare il valore delle variabili sbMinutes e swHours tenendo attivati due diversi
ingressi ifSetUpMinutes e ifSetUpHours, rispettivamente. Si osservi che all’interno di ogni WHILE e stato inserito un timer di
ritardo, tDelay, per fare in modo che I'incremento della variabile sia piu lento per dare modo all’utente di disattivare I'ingresso
quando la variabile assume il valore voluto. Naturalmente il valore da assegnare ai minuti o alle ore é limitato e quindi viene
aggiunto un IF all’interno del while per controllare questo limite. La spiegazione dell'istruzione WAIT 1 viene rimandata in
seguito.

MAIN:
WHILE (ifSetUpHours) ;While the input is actived:
IF tDelay ;if_the timer is expired
tDelay = 500 ;reload the timer,
swHours = swHours + 1 ;increase the hours counter.
IF swHours GE 168 ;If the hours are more than 167 (great equal than 168)
swHours = 0 ;reset the hours counter.
ENDIF
ENDIF
WAIT 1
ENDWHILE
WHILE (ifSetUpMinutes) ;While the input is actived:
IF tDelay ;if_the timer is expired
tDelay = 500 ;reload the timer,
sbMinutes = sbMinutes + 1 ;increase the minutes counter.
IF sbMinutes GE 60 ;If the minutes are more than 59 (great equal than 60)
Ng?%lnutes =0 ;reset the minutes counter.
ENDIF
WAIT 1
ENDWHILE
IT 1

WA
JUMP MAIN
END
7.2.4 SWITCH-ENDSWITCH

Nel QView 6 ¢ stata introdotta la istruzione SWITCH. Questa istruzione permette di analizzare una certa espressione e eseguire
delle righe di codice diverse a seconda del risultato di questa espressione. La sintassi é&:

SWITCH(<ex%ression>)

CASE <value 1>

< code_lines for value 1> [; comments]
CASE <value 2>..<value 3>

< code_ lines for values between value 2 and value 3> [; comments]

CASE <value 4>, <value 5>..<value 6>
[DEFKSE% lines for value 4 and for values between value 5 and value 6> [;comments]
< code lines for default>] [; comments]

ENDSWITCH
Un esempio banale di un controllo della temperatura rilevata da un sensore che scrive il suo valore nella variabile Temperature.

SWITCH(Temperature)
CASE 0

CloseDoor = 1
WarmUp = 100
IceAlarm =1
QutOfRange = 0
CASE 1..10
CloseDoor = 1

CloseDoor =1
WarmUp = 15
IceAlarm = 0
OutOfRange =0
CASE 16..2
CloseDoor = 0
WarmUp = 0
IceAlarm =
OutOfRange
EFAULT

D
OutOfRange = 1
ENDSWITCH

Il

7.2.5 WAIT

Attende il verificarsi di una condizione o di un evento. L'istruzione WAIT € una istruzione molto importante poiche quando viene
eseguita e la <condizione> & falsa, I'esecuzione delle istruzioni passa al task successivo. E comunque necessario fare una
precisazione in questo contesto; infatti I'esecuzione dell'istruzione WAIT comporta comunque la cessione del controllo al task
successivo quando viene incontrata la prima volta, senza che la condizione sia controllata. Quando il controllo del flusso
istruzioni ritorna al task in questione viene rieseguita I'istruzione WAIT e quindi controllata la condizione. Per maggiori
informazioni fare riferimento al capitolo dedicato al multitasking. La sintassi &:

WAIT <condizione>
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7.2.6 JUMP

Esegue un salto incondizionato all'istruzione locata all'etichetta specificata. La sintassi e:

JUMP <etichetta>

Esempio

L'esempio classico per l'istruzione JUMP ¢ quello che viene ripetuto in ogni task per saltare dalla fine del codice all’inizio, cioé
all’etichetta MAIN. Questa istruzione per il controllo di flusso puo essere utilizzata anche in altri punti del task. JUMP ¢ un salto
incondizionato, si puo renderlo condizionato in combinazione con un IF con lo scopo di deviare il flusso di codice in base al
verificarsi di particolari condizioni.

7.2.7 ETICHETTE

Tramite le etichette € possibile localizzare determinati punti nella sequenza delle istruzioni dell'applicativo. Vengono utilizzate
per modificare il flusso di esecuzione delle istruzioni (comando JUMP del QCL). Quando viene inserita un'etichetta nelle
istruzioni & necessario che sia seguita dai due punti “:”, mentre se si fa riferimento all'etichetta stessa si deve scrivere il nome
senza i due punti.

Esempio jump incondizionato

Labell: ; labeled line
< code line >
< code line >

JUMP Labell ;Jump to the label instruction

Esempio jump condizionato

Labell: . ; labeled line
< code line > L .
IF <condition> ;If the condition_is true
ENS%%P Labell ;Jump to the label instruction

7.2.8 SUBROUTINE

Quando, all'interno di una stessa unit, vi & una parte di codice ripetuta piu volte & utile definire una subroutine. L'esecuzione
del codice in essa contenuto avverra ogni qualvolta viene incontrata una istruzione di chiamata a subroutine (CALL). La
subroutine viene identificata da un nome preceduto dalla parola chiave SUB e deve terminare con la parola chiave ENDSUB.
Vedi anche istruzione CALL.

Per interrompere una subroutine prima del termine della stessa inserire la parola chiave RETURN.

7.2.9 CALL

Call to Subroutine: esegue un salto incondizionato alla prima istruzione della subroutine identificata dal nome. Al termine della
subroutine (identificata da ENDSUB) il flusso del programma continua dalla istruzione successiva alla CALL.

CALL <nome_subroutine>

| Queste righe di codice vanno poste oltre la parola chiave END, cioé oltre la fine della unit operativa. |

Introduciamo una subroutine per calcolare la lunghezza di una diagonale di un quadrato data la lunghezza di un lato.

L'esempio a seguire illustra il richiamo della subroutine:

MAIN:
10urLong = ;This is the square edge
ALL CAL DIAG iSubroutine call

WAIT 1
JUMP MAIN
END

————————————— This subroutione calcs the square diagonal-----------------
SUB CALC DIAG
ENgsEgurSlng SQRT(2 * POW(glOurlong,2))

7.2.10 NOP
No operation; questa istruzione non ha nessun effetto sul programma e puo essere utilizzata per introdurre dei ritardi.

7.3 Istruzioni dedicate alle uscite digitali
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Sono le istruzioni che permettono di attivare o disattivare un’uscita digitale. L'attivazione e la disattivazione possono essere
eseguite anche tramite I'operatore di assegnamento (<nome uscita> = 1) ma le istruzioni dedicate sono pil veloci.

7.3.1 SETOUT

Attiva una uscita digitale. La sintassi € la seguente:

SETOUT <nome uscita>

7.3.2 RESOUT

Disattiva una uscita digitale. La sintassi € la seguente:

RESOUT <nome uscita>

L’uscita ofOutputl viene attivata con il comando SETOUT quando la variabile shSeconds assume il valore 20 solo se I'ingresso
ifEnableO1 e attivo. Tale uscita viene poi resettata quando shSecondi assume il valore 40.

Introduciamo un esempio in cui vengono cambiate di stato un’uscita a seconda del valore di una variabile:

MAIN:
IF (sbSeconds EQ 20) AND ifEnableOl ;If sbSeconds is equal to 20 and the input si actived
ENSEIOUT ofOutputl ;set the output
IF sbSecondi EQ 40 ;When the sbSeconds is equal to 40
RESOUT ofOutputl ;reset the output
ENDIF
WAIT 1
JUMP MAIN
END

7.4 Istruzioni di sistema

Sono le istruzioni che permettono il controllo dell'esecuzione delle unit (unita contenenti il codice QCL o LADDER) del
programma utente. Tali istruzioni saranno pil comprensibili quando sara spiegato il sistema di multitasking adottato.

7.4.1 SUSPEND

Esegue la sospensione dell'esecuzione della unit di programma specificato.

Tale istruzione pu0 essere utilizzata da una unit per bloccare I'esecuzione di un altra unit oppure per bloccare I'esecuzione di se
stessa. In questo caso bisogna ricordare che la unit in questione, essendo sospesa, non puo piu riattivarsi ma tale operazione
deve essere eseguita da una delle altre unit in esecuzione. La sintassi dell'istruzione SUSPEND é:

<unit name>.SUSPEND

7.4.2 RESUME

Esegue il ripristino dell'esecuzione delle istruzioni di una unit sospesa. Tale istruzione fa riprendere I'esecuzione di una unit
sospesa dall'istruzione successiva a quella eseguita al momento della sospensione. La sintassi &:

<unit name>.RESUME

RESUME produce degli effetti solamente se la unit <unit name> era sospesa.
7.4.3 RESTART

Esegue una “ripartenza” dell'esecuzione di una unit di programma dalla prima istruzione. Tale istruzione non altera lo stato di
sospensione della unit in questione; ciod significa che se viene eseguito un RESTART di una unit sospesa, quest'ultima si
predispone per I'esecuzione della prima istruzione ma rimane tuttavia sospesa fino alla sua attivazione con l'istruzione
RESUME. La sintassi &:

<nome_task>.RESTART

Per comprendere meglio il significato di queste istruzioni di sistema si veda il capitolo “Multitasking”.
7.5 Variabili di sistema

Il sistema QMOVE mette a disposizione delle variabili legate al sistema operativo interno di sola lettura; i nomi di queste
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variabili sono predefiniti, non possono cioé essere cambiati dall'utente.
7.5.1 is_suspended

Fornisce lo stato di una unit:

e 0 = unit in esecuzione;
e 1 = unit sospesa.
La sintassi e:

<unit name>.is suspended

7.5.2 watchdog

Il Watchdog task indica che il tempo di esecuzione di una unit del progetto ha superato i 200 ms. E la stessa informazione che
compare nel pannello Monitor - CPU alla voce Watchdog Task. La sintassi é:

QMOVE .watchdog

7.5.3 time_task lost

Indica che una unit a tempo del progetto ha perso un evento. E la stessa informazione che compare nel pannello Monitor - CPU
alla voce Time task Lost. Una unit a tempo deve essere eseguita con tempistiche deterministiche. Questi tempi potrebbero non
venire rispettati a causa del grosso impegno nell'eseguire il codice inserito nella stessa unit. Se questo succede si parla di Time
task lost avvenuto.

La sintassi é&:

QMOVE.time task lost

7.5.4 battery_low

Indica che la batteria ha un livello di carica basso. Il led BATT lampeggia. Questa informazione ha senso solamente nei modelli
di QMOVE forniti di batteria tampone per la memoria RAM.
La sintassi e:

QMOVE.battery low

7.5.5 battery_down

Indica che la batteria & scarica. Il led BATT & acceso. Questa informazione ha senso solamente per i modelli di QMOVE che sono
dotati di batteria tampone per la memoria RAM.
La sintassi &:

QMOVE.battery down

Esistono altre variabili di sistema che dipendono dal firmware della CPU utilizzata. Per accedere a queste variabili si utilizza la
sintassi:

QMOVE.sys001
QMOVE. sys002

QMOVE. sys016

Il significato di queste variabili deve essere ricercato nella documentazione firmware della CPU.

7.6 Funzioni matematiche

7.6.1 Elevamento a potenza

Esegue I'elevamento alla potenza della base. La sintassi é&:

POW(<base>, <exponent>)

Esempio: gsMaxVal = 29"
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gsMaxVal = POW(2,gwNbit)

7.6.2 Radice quadrata

Calcola la radice quadrata dell'argomento dato. La sintassi e:

SQRT(<radicand>)

Esempio: gslpot = v(gsL1® + gsL2?)

gsIpot = SQRT(POW(gsL1,2)+POW(gsL2,2))

7.6.3 Logaritmo naturale

Calcola il logaritmo naturale dell'argomento dato. La sintassi &:
LN(<val>)
Esempio: gsValue = In gsMaximum

gsValue = LN(gsMaximun)

7.6.4 Esponenziale

Esegue I'elevamento a potenza del numero di Nepero. La sintassi é:

EXP (<exponent>)

Esempio: gsA = e

gsA =EXP(2)

7.6.5 Valore assoluto

Ritorna il valore assoluto dell'argomento. La sintassi e:
ABS (<variable>)
Esempio: gIModule = | glValue |

glModule = ABS(glValue)

7.6.6 Shift a sinistra

Esegue una operazione di shift a sinistra di n bit sull'argomento.

MSE LSE
SHLL -+— 0

Lo shift & da intendersi indifferentemente sia logico che aritmetico, ossia:

- | bit che escono dalla sequenza a sinistra vengono perduti.
- | bit che entrano nella sequenza a destra sono degli 0.

Dal punto di vista matematico si tratta della moltiplicazione dell'argomento per la potenza 2" n.
La sintassi e:

SHLL (<variable>,<bits>)
Esempio:

glNewValue = SHLLéglValue, 1%
; Se glValue = &B0B001100 (12) allora glNewValue = &B00011000 (24)

7.6.7 Shift a destra
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Esegue una operazione di shift a destra di n bit sull'argomento.
MSE LSB
SHLR 0—™ -

Lo shift & da intendersi aritmetico (non logico), ossia:

- | bit che escono dalla sequenza a destra vengono perduti.
- | bit che entrano nella sequenza a sinistra sono delle copie del bit piu significativo (ossia di quello piu a sinistra).

Dal punto di vista matematico si tratta della divisione dell'argomento per la potenza 2" n. Questa interpretazione continua a
valere anche per i numeri negativi scritti in complemento a 2.
La sintassi é:

SHLR(<variable>,<bits>)

Esempio:
glValue = SHLR(E alue, 1)
; S Value = &B00001100 212 allora glNewValue = &B00000110 (6)
; Se glValue = &B11110011 (-12) allora glNewValue = &B111116001 (-6)

7.6.8 Moltiplicazione e divisione

Esegue una moltiplicazione di valori interi a 32 bit con risultato a 64 bit e una successiva divisione per valore intero a 32 bit. Il
risultato & un valore di 32 bit.
N.B. Se viene eseguita una divisione per zero, la CPU andra in stato “Division by zero error”.
La sintassi é&:
MULDIV(<factorl>,<factor2>,<divisor>)

Esempio: glValue=a*b/c

glvalue = MULDIV(a, b, c)

7.6.9 Resto di moltiplicazione e divisione

Esegue una moltiplicazione di valori interi a 32 bit con risultato a 64 bit e una successiva divisione per valore intero a 32 bit. Il
risultato & il resto della divisione.
N.B. Se viene eseguita una divisione per zero, la CPU andra in stato “Division by zero error”.
La sintassi é:
RMULDIV(<factorl>,<factor2>,<divisor>)

Esempio: glValue =a*b % c

glvalue = RMULDIV(a, b, c)

7.6.10 Arrotondamenti all'intero piu vicino

ROUND | Esegue un arrotondamento di un valore in floating point all'intero piu vicino.

TRUNC | Esegue un arrotondamento di un valore in floating point all'intero piu vicino non maggiore di grandezza rispetto al valore dato.
FLOOR | Esegue un arrotondamento di un valore in floating point all'intero piu vicino non superiore al valore dato.

CEIL Esegue un arrotondamento di un valore in floating point all'intero pil vicino non inferiore al valore dato.

La sintassi €:

ROUND (<variable>
TRUNC(<variable>
FLOOR(<variable>
CEIL(<variable>)
Esempio:
gsValue = ROUND(2. 7) ,rlsulta 3.0
gsValue = ROUND(-2.7) ;risulta -3.0
gsValue = TRUNC(2.7) rlsulta 2.0
gsValue = TRUNC(-2.7) irisulta -2,0
gsValue = FLOOR(2.7) ,rlsulta 2.0
gsValue = FLOOR(-2.7) ;risulta -3.0
gsValue = CEIL(2.7) rlsulta 3.0
gsValue = CEIL(-2.7) irisulta -2.0

7.6.11 Operatori di classificazione
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ISFINITE Controlla se il numero dato ha valore finito.
ISINF Controlla se il numero dato ha valore infinito.
ISNAN Controlla se il numero dato ha valore NaN.
ISNORMAL | Controlla se il numero dato ha valore normale.

La sintassi &:

ISFINITE(<variable>)
ISINF(<variable>
ISNAN(<variable>
ISNORMAL (<variable>)

Esempio:

un valore finito, altrimenti 0

un valore infinito, altrimenti 0.

un NaN (Not a Number), altrimenti 0 . .
un valore normale (non zero, non infinito, non NaN), altrimenti 0

gfValue
gfValue
gfValue
gfvalue

ISFINITE(gsValue) ;risulta
ISINF§gsVa1ue ;risulta
ISNAN(gsValue ;risulta
ISNORMAL (gsValue) ;risulta

se gsValue
se gsValue
se gsValue
se gsValue

L

7.7 Funzioni trigonometriche

7.7.1 Seno

Calcola il seno di un angolo espresso in radianti. La sintassi &:
SIN(<angle>)
Esempio: gsYPos = ssRadius x SIN gsalpha

gsYPos = ssRadius * SIN(gsalpha)

7.7.2 Coseno

Calcola il coseno di un angolo espresso in radianti. La sintassi &:
COS(<angle>)
Esempio: gsXPos = ssRadius x COS gsalpha

gsXPos = ssRadius * COS(gsalpha)

7.7.3 Tangente

Calcola la tangente di un angolo espresso in radianti. La sintassi é:
TAN (<angle>)
Esempio: gsMyVal = TAN gsalpha

gsMyVal = TAN(gsalpha)

7.7.4 Cotangente

Calcola la cotangente di un angolo espresso in radianti. La sintassi &:
COT (<angle>)
Esempio: gsMyVal = COT gsalpha

gsMyVal = COTG(gsalpha)

7.7.5 Arcoseno

Calcola I'angolo, espresso in radianti, il cui seno & uguale all'argomento. La sintassi é:
ASIN(<arc>)
Esempio: gsAngolo = ASIN Arc

gsAngolo = ASIN(Arc)
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7.7.6 Arcocoseno

Calcola I'angolo, espresso in radianti, il cui coseno & uguale all'argomento. La sintassi é:
ACOS (<arc>)
Esempio: gsAngolo = ACOS Arc

gsAngolo = ACOS(Arc)

7.7.7 Arcotangente

Calcola I'angolo, esresso in radianti, la cui tangente & uguale all'argomento. La sintassi é:

ATAN(arc)

Esempio: gsMyVal = ATAN Arc

gsMyVal = ATAN(Arc)

7.7.8 Avvertenza

In generale, nelle funzioni trigonometriche, gli angoli vengono espressi in radianti. Essendo p un numero irrazionale (non finito)
e potendolo rappresentare con una precisione di 7 cifre dopo il punto decimale, si introduce una approssimazione nei calcoli
trigonometrici.

Altro limite e dato dai calcoli trigonometrici che danno come risultato un numero infinito, che non pud sicuramente essere
rappresentato con un numero floating point a singola precisione (7 cifre). Per esempio il risultato della tangente di p/2 € un
numero molto grande in modulo con segno negativo, risultato che evidentemente si allontana da +infinito (risultato corretto).

ESEMPIO: tang p/2 = tang 1.570796371 = -22877332 ;
arctg -22877332 = -1.570796371 = - p/2 (!!)

Non & possibile calcolare la tangente di p/2 con la formula:
tang p/2 = (sen p/2) / (cos p/2)
in quanto viene eseguita una divisione per zero.
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8. Applicazione di esempio

L'applicazione che vogliamo sviluppare ha lo scopo di applicare le informazioni finora introdotte.
Il progetto che andremo a realizzare avra:

¢ una unit per gestire una macchina a stati;
e una unit per realizzare un sequenziatore;
e una unit per rilevare gli ingressi digitali ed attivare uscite digitali.

8.1 Nuovo Progetto

Crea un nuovo progetto con
¢ File - New Project

inserisci il Project Name come MyApplication.
8.2 Aggiungi la unit di configurazione

Seleziona
¢ File - Add Unit - Configuration Unit
e chiamala CONFIG. La unit verra gia precompilata con tutte le parole chiavi che distinguono i vari gruppi di variabili. Nella unit

di configurazione € fondamentale, per ora, dichiarare quale hardware si vuole utilizzare.
In questo esempio abbiamo usato

BUS
1 1P51F 30
3 iMG8F

Per ora non dichiariamo niente altro nella unit di configurazione.

8.3 Aggiungi le unit QCL
8.3.1 Unit MANAGER

Seleziona
¢ File - Add Unit - Qcl Unit
e chiamala MANAGER. Lascia la proprieta Task Mode come Normal. La unit aggiunta presenta il seguente codice pre-inserito:

MAIN:

WAIT 1
JUMP MAIN
END

Questa unit MANAGER dovra gestire una macchina a stati rappresentata nel seguente schema:
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Il software della unit MANAGER dovra gestire le transizioni di stato e dovra fornire alcune informazioni (per esempio quale & lo
stato attuale).
Dichiara le seguenti variabili e costanti nella unit MANAGER:

CONST
ALARM STATE 0 ouT
MANUAL_STATE 1 out
AUTOMATIC_STATE 2 OUT

GLOBAL
NewState B 1IN ;New state requested
State B OUT iActual state

BEGIN

MAIN:

WAIT 1
JUMP MAIN
END

Ora aggiungi il seguente codice:

CONST
ALARM STATE 0 ouT
MANUAL_STATE 1 ouTt
AUTOMATIC_STATE 2 OUT

GLOBAL
NewState B 1IN ;New state requested
State B OUT iActual state

BEGIN

MAIN:

SWITCH State
CASE ALARM STATE

here the code to do when the state is ALARM
CAéE MANUALisTATE

here " the code to do when the state is MANUAL
CASE AUTOMATIC STATE

;Put_here the code to do when the state is AUTOMATIC

ENDSWITCH

WAIT 1

JUMP MAIN
END

La variabile State & considerata un OUT per questa unit. Se un‘altra unit vuole far cambiare lo stato alla macchina non puo
agire direttamente su State perché solo la unit MANAGER la pud modificare. Viene quindi predisposta una variabile NewState
che viene usata da MANAGER come un IN nel seguente modo

ALARM STATE 0 OuT
MANUAL STATE 1 out
AUTOMATIC_STATE 2 OUT

GLOBAL
NewState B 1IN ;New state requested
State B OUT ‘Actual state

BEGIN

MAIN:
SWITCH State

CASE ALARM STATE
;Put here the code to do when the state is ALARM

CASE MANUAL STATE

;Put here the code to do when the state is MANUAL
CASE AUTOMATIC STATE .

;Put_here the code to do when the state is AUTOMATIC
ENDSWITCH

;Check if there 1s a change state request
IF State NEQ NewState

SWITCH NewState

CASE ALARM_STATE

SWITCH State
CASE MANUAL_STATE
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;Put here the code for MANUAL to ALARM trasition
CASE AUTOMATIC STATE
;Put _here the code for AUTO to ALARM trasition
ENDSWITCH
CASE MANUAL STATE
SWITCH State
CASE ALARM STATE
;Put here the code for ALARM to MANUAL trasition
CASE AUTOMATIC STATE
;Put _here the code for AUTO to MANUAL trasition
ENDSWITCH
CASE AUTOMATIC STATE
SWITCH State
CASE MANUAL STATE
;Put here the code for MANUAL to AUTO trasition
ENDSWITCH
ENDSWITCH
State = NewState ;The trasition is done

ENDIF

WAIT 1

JUMP MAIN
END

Come puoi osservare, quando la NewState & diversa da State viene eseguito uno dei possibili codici associati ad una delle 5
possibili transizioni. Alla fine della transizione lo stato della macchina viene definitivamente impostato al nuovo stato richiesto.
Una unit che volesse utilizzare la unit MANAGER dovra quindi usare un codice di questo tipo:

MANAGER.NewState = MANAGER.AUTOMATIC STATE
WAIT MANAGER.State EQ MANAGER.NewState

Per esempio per comandare il cambio di stato in automatico.

8.3.2 Unit SEQUENC

Aggiungi un'altra unit con la stessa proprieta di MANAGER e chiamala SEQUENC. Per ottenere una sequenza devi scrivere un
codice come questo:

GLOBAL
Start F 1IN ;Start sequence input
Sequence W OUT ;This is the step of the sequence

start rise up F ;Local variable to check the rise edge of Start input

BEGIN
MAIN:

IF Start .
IF start rise up
start Tise up = 0
SeEuence =1 ;Start the sequence
ENDI

ELSE

start rise up =1
Seguence =0 ;Reset the sequence
ENDI

WAIT 1
JUMP MAIN
END

Come puoi osservare quando la variabile Start vale 0 (FALSE) la variabile Sequence viene azzerata (questo serve per impedire
alla sequenza di funzionare). Quando la variabile Start vale 1 (TRUE) la variabile Sequence viene impostata al valore 10 solo la
prima volta perché poi la variabile start_rise_up viene impostata a 0.

Ora aggiungi il codice per usare la variabile Sequence.

CONST
OFF 0 O0uT
ON 1 ouT

GLOBAL
Start
Force
Sequence
Signal

IN ;Start sequence input

IN ;Force the signal output to ON
OUT ;This is the Step of the_sequence
OUT ;This is an output signal

m M=

start rise up

TIMER
time on
time off

BEGIN
MAIN:

IF Start .

IF start _rise up
start_?lse_ﬁg =0
Seguence =1

ENDI

;Local variable to check the rise edge of Start input

;Start the sequence

start rise up =1
Sequence = 0 ;Reset the sequence
ENS%gnal = Force ;Force the signal

;This is the sequence management
IF Sequence EQ 10 ;First step
Signal = OFF ;Reset signal

37/94



QVIEW 6.0

t1me off = 1000 ;1000 ms = 1 s
guence = 20

ENDI

IF Sequence EQ 20 ;Second step |
IF time off ;Wait time expired

guence = 30

ENDI

END

IF Sequence EO 30 ;3rd step
Signal = ;Set signal
time on = 500 ;500 ms™= 0.5 s
Seguence = 40

IF Sequence EQ 40 ;4th step
IF time on wa1t time expired

Seguence = 50

ENDI

ENDIF

IF Sequence EQ 50 ;5th step
Seguence = 10

WAIT 1

JUMP MAIN

END

Quando la variabile Sequence & impostata a 10, viene eseguito il codice contenuto in

IF Sequence EQ 10

che la fa diventare 20 e via cosi eseguendo passo dopo passo la sequenza. La sequenza consiste nell'impostare a OFF la
variabile Signal per 1s e quindi impostare ad ON per 0.5s e quindi ripetere la sequenza all'infinito (finché Start vale TRUE).
Inoltre & stato aggiunto anche I'input Force che, quando la sequenza non ¢ attiva, serve per forzare Signal a ON .

8.3.3 Unit COMMAND

Aggiungi la unit COMMAND e inserisci il seguente codice:

GLOBAL
ForceOutput F OouT
INPUT
Selector F REFERENCE
Enable F REFERENCE
ManualButton F REFERENCE
BEGIN
MAIN:

WAIT 1
JUMP MAIN
END

In questa unit dichiariamo tre REFERENCE ad tre ingressi digitali. Poi vedremo come assegnare questi REFERENCE a tre ingressi
digitali veri e propri che andremo ad aggiungere nella unit di configurazione. Ora aggiungi il seguente codice:

GLOBAL
ForceOutput F ouT
INPUT
Selector F REFERENCE
Enable F REFERENCE
ManualButton F REFERENCE
BEGIN
MAIN:

IF_Enable ;If enable_input is on
IF Selector ;If selector in on automatic position
:Go to automatic state
MANAGER .NewState = MANAGER.AUTOMATIC STATE
ELgéIT MANAGER.State EQ MANAGER.AUTOMATIC STATE

;Go to manual sta
MANAGER. NewState = MANAGER MANUAL STATE
WAIT MANAGER.State EQ MANAGER.MANUAL STATE
ELSE

;Go to alarm state
MANAGER.NewState = MANAGER.ALARM STATE
ENg%ET MANAGER.State EQ MANAGER.ALARM STATE

ForceOutput = ManualButton ;Replay the input value to an output variable

WAIT 1
JUMP MAIN
END

Questo codice serve per decidere quando eseguire le transizioni di stato. Ora &€ importante completare il codice scritto in
MANAGER in questo modo:

CONST
ALARM STATE 0 ouT
MANUAL_STATE 1 ouT
AUTOMATIC STATE 2 OUT
GLOBAL
NewState B 1IN ;New state requested
State B OUT iActual state
BEGIN
MAIN:

SWITCH State
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CASE ALARM STATE
;Put _here the code t
SEQUENC.Start = SEQUENC.OFF
SEQUENC. Force SEQ
CASE MANUAL_ STATE
;Put here the code to do when the state is MANUAL
EQUENC.Force = COMMAND ForceOutput
CASE AUTOMATIC STA
here the code to do when the state is AUTOMATIC
éEOUENC Start = SEQUENC
ENDSWITCH

;Check if there is a change state request
IF State NEQ NewState

SWITCH NewState

CASE ALARM_STATE

SWITCH State
CASE MANUAL STATE
;Put here the code for MANUAL to ALARM trasition
SEQUENC.Start = SEQUE
SEQUENC.Force = SEOUENC OFF
CASE AUTOMATIC STATE
;Put here the code for AUTO to ALARM trasition
SEQUENC.Start = SEQUENC.OFF
SEQUENC.Force = SEQUENC.OFF
ENDSWITCH

CASE MANUAL_STATE

SWITCH State
CASE ALARM_STATE
A here the code for ALARM to MANUAL trasition
éEQUENC Start = SEQUENC.OFF
SEQUENC.Force = SEQUENC OFF
CASE AUTOMATIC STA
here the code for AUTO to MANUAL trasition
éEQUENC Start = SEQUENC.OFF
SEQUENC.Force SEQUENC.OFF
ENDSWITCH

CASE AUTOMATIC STATE
SWITCH State
CASE MANUAL STATE
;Put here the code for MANUAL to AUTO trasition
$EQUENC.Start = SEQUENC.OFF
SEQUENC.Force = SEQUENC.OFF
ENDSWITCH
ENDSWITCH
State = NewState ;The trasition is done
ENDIF

WAIT 1
JUMP MAIN

END

Come si vede, in questo semplice esempio, le operazioni che vengono eseguite durante le transizioni di stato sono tutte uguali
e servono per bloccare qualsiasi operazione sulla variabile Signal. Poi si vede che quando lo stato & in manuale I'attivazione di
Signal & affidata a COMMAND.ForceOutput che a sua volta ha lo stesso valore di un ingresso digitale. Nello stato automatico
invece viene attivata la seguenza gestita nella unit SEQUENC.

Ora facciamo I'ultima aggiunta alla unit di configurazione CONFIG in questo modo:

INPUT
ManAuto F 3.INPO1
PowerOn F 3.INPO2

Push F 3.INPO3
REFERENCES

COMMAND . Selector = ManAuto

COMMAND . Enable = PowerOn

COMMAND . ManualButton = Push

In questo modo i simboli della unit COMMAND: Selector, Enable, ManualButton sono dei riferimenti associati agli ingressi
dichiarati come: ManAuto, PowerOn, Push rispettivamente. E' evidente che la funzionalita dei REFERENCE in questo esempio e
poco utile. Infatti al posto del simbolo Selector avrei potuto usare direttamente ManAuto. Si apprezza la potenzialita dei
REFERENCE se si vuole riutilizzare il codice scritto per la unit COMMAND. Infatti potrei aggiungere una nuova unit chiamata
COMMAN2 contenente lo stesso indentico codice QCL di COMMAND ma con i REFERENCE riferiti ad altri input. Ottengo in questo
modo un codice perfettamente riutilizzabile.
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9. Funzioni di libreria QCL

Una funzione QCL ¢ una parte di codice che permette di risolvere particolari problemi, di eseguire elaborazioni dati, di fornire
specifiche funzionalita ad un progetto per QMOVE. Per poter utilizzare una funzione QCL nel codice di una unit & sufficiente
richiamarla passandole gli argomenti necessari, come si trova descritto in seguito.

Questo modo di procedere comporta alcuni vantaggi:

¢ Sj trovano parti di codice gia scritte, collaudate, che risolvono in maniera ottimizzata i pit frequenti
problemi che si affrontano nella stesura di un progetto.

« Offrono la possibilita di riutilizzare quante volte si vuole la stessa funzione, senza doversi preoccupare di
riscriverla ogni volta.

* Esiste la possibilita di aggiornare semplicemente la libreria man mano che questa viene dotata di nuove
funzioni, mantenendo una assoluta compatibilita con gli applicativi gia sviluppati.

La lista delle funzioni QCL disponibili e la relativa modalita di utilizzo € disponibile nel menu Help > Functions info,
richiamabile in qualsiasi momento dall’ambiente di sviluppo.

Se indichiamo con FuncQCLO1 una qualsiasi funzione della libreria, la sintassi corretta per richiamarla € la seguente:
FuncQclO1(<arguments list>)

Non restituendo valori, le funzioni non possono essere utilizzate a destra di un assegnazione o come parte di un'espressione in
un istruzione IF, FOR o WHILE.

s1lType0l = FuncQCLOIL(...) !COMPILING ERROR!
IF (FuncQCl01(...) AND ...) !COMPILING ERROR!
FOR (sInt@l = 1, sInt@1 LT FuncQCLO1(...), ...) !'COMPILING ERROR!
WHILE (FuncQCLOL(...) LT 24) !COMPILING ERROR!

Anche se una funzione QCL non restituisce alcun valore, € tuttavia possibile che una funzione QCL imposti dei valori a dei
parametri passati come argomento e quindi in pratica &€ come se si avessero piu valori di ritorno.

Vediamo alcuni semplici esempi:

AC10AvergArr (MyArray, average value, ok calc)

La funzione calcola il valore medio di un array passato come argomento. In questo caso MyArray & un parametro di ingresso e
si vuol calcolarne il valore medio.

average value e ok calc sono parametri di uscita e sono rispettivamente il valore medio calcolato dalla funzione e un flag
indicante il calcolo completato. Quando ok _calc assume valore 1 significa che la funzione ha terminato i suoi calcoli e quindi e
possibile recuperare tale valore leggendo la variabile average_value.

Per ciascuna funzione & poi indicato in quale parte dell’'unita chiamarla; infatti vi sono funzioni, che proprio per le operazioni

che devono svolgere, vanno chiamate in una parte ciclica del codice, mentre alcune altre possono essere chiamate anche in

una parte non ciclica del codice. Con parte ciclica si intende la parte del codice QCL che viene eseguita ad ogni scansione del
programma.

Con parte non ciclica si intende la parte di codice che non viene eseguita ciclicamente perché mancano determinate condizioni
(per esempio se il codice & contenuto in una istruzione IF la cui condizione non & vera).

L'indicazione sul “dove” richiamare una funzione & riportato nella descrizione di ciascuna funzione (Help > Functions info).
Un’altra caratteristica da tenere presente per alcune funzioni € il fatto che, quando sono necessarie operazioni che impiegano
molto tempo, la funzione stessa si preoccupa di eseguire un’istruzione di WAIT al suo interno, ogni 180 millisecondi. Questo per
impedire il “blocco” dell’'esecuzione della unit dovuto a compiti particolarmente gravosi. Solitamente in funzioni di questo tipo &
presente un argomento di tipo flag che pu6 essere monitorato per verificare quando la funzione ha terminato il suo compito.
Nell’help della funzione utilizzata viene indicato chiaramente il tipo degli argomenti che la funzione si aspetta. Se questo tipo
non viene rispettato dal programmatore viene generato un errore in fase di compilazione del progetto.

9.0.1 Esempio di utilizzo delle funzioni QCL

Supponiamo di utilizzare la funzione di calcolo della media aritmetica dei valori contenuti in un array (AC10AvergArr):

GLg?ﬁberaEe L ; This is used as the result variable

ARREDone ; This flag is used to result variable
aslMyArray 10 L ; Array System

BEGIN

MAIN:

IF NOT gfDone
ENS%%OAvergArr(aslMyArray, glAverage, gfDone)

WAIT 1
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JUMP MAIN
END
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10. Editor Ladder

Il Ladder (logica a contatti) & un linguaggio nato per la programmazione dei PLC, per cui & molto performante per la gestione di
ingressi uscite e piccole sequenze.

Si da per scontato che I'utilizzatore conosca il linguaggio Ladder IEC1131; in caso contrario si consiglia di integrare il presente
manuale con un corso PLC generico.

10.1 L’esecuzione del rung

Nel linguaggio LADDER bisogna tener presente che i vari elementi sono analizzati, all'interno del rung, partendo dall’angolo in
alto a sinistra e spostandosi dall’alto in basso e da sinistra a destra (Figura 1).

Figura 1: esecuzione del rung.

>

Nel caso si inserisca un elemento che occupa pil celle (ad esempio un contatore), la cella che fa da riferimento per lo
svolgimento del rung & quella in alto a sinistra.

Il nome delle variabili per il programma Ladder sono dichiarate nella unita di configurazione e vanno dichiarate come descritto
nella sezione QCL. Le stesse variabili possono essere utilizzate sia in Ladder che in QCL anche contemporaneamente.

In seguito si guida I'utente all'inserimento di un elemento nella rete LADDER utilizzando le voci del menu predisposte.

10.2 Come inserire un elemento

Spieghiamo con un esempio come inserire un elemento in una rete LADDER. Innanzitutto si deve inserire una nuova unita
LADDER selezionando File > Add unit > Ladder unit. Comparira la finestra di Figura 2.

Figura 2: inserimento di nuova unita LADDER.
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Una volta confermato con Ok una nuova unita verra ad aggiungersi nella finestra UNIT MANAGER. Con un doppio click su
guesta nuova unita LADDER si aprira I'editor LADDER. A questo punto & possibile inserire il primo elemento della nostra rete
LADDER utilizzando la “libreria degli elementi LADDER"” come mostrato in figura 3.

| Figura 3: Libreria dei blocchi LADDER |
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A questo punto & possibile scegliere tra i vari elementi messi a disposizione e posizionarli sulla griglia dell’editor. L'operazione
si puo fare sia trascinando I'elemento sulla posizione voluta, sia facendo un doppio click sull’elemento stesso. In questo caso
I’elemento viene posizionato nella casella dell’editor evidenziata in quel momento.

E’ possibile selezionare I'elemento ladder da inserire scegliendolo anche dalla lista degli “ultimi elementi inseriti”.

L'elemento ladder deve essere inserito in una rete esistente. Se la rete non esiste bisogna crearla inserendo un nuovo “rung”.
Per inserire un nuovo “rung” selezionare il menu Edit > New Rung.

Se supponiamo di voler inserire il contatto normalmente aperto si deve selezionare Normally Open Contact e sull’editor appare
il simbolo del contatto (Figura 4).

Figura 4: contatto normalmente aperto inserito in una rete LADDER.
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La libreria degli elementi LADDER & formata da una serie di categorie in cui sono suddivisi i vari elementi disponibili per
comporre la rete LADDER. Nel seguito faremo una veloce carrellata su queste categorie. Il programmatore tenga presente che
la maggior parte degli elementi sono elementi di tipo standard (IEC1131) e tutti sono dotati di un help in linea richiamabile
direttamente da Qview (selezionando |'elemento e premendo F1).

L'elemento inserito nella figura 4 non ha associata nessuna variabile. Per associare una variabile all'elemento inserito si deve
evidenziare I'’elemento e selezionare il menu Edit > Element Properties. Apparira la finestra di figura 5.

Figura 5: proprieta del blocco.
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I campo “Note” serve per associare all’elemento delle notazioni utili per il programmatore. Una volta compilata la finestra
come in figura 5, la rete LADDER appare come in figura 6.

Figura 6: proprieta del blocco.
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La finestra delle proprieta dell’elemento permette di inserire tutte le variabili di cui I'elemento necessita. Alcune variabili pero
non sono obbligatorie. Per esempio in figura 7 si osserva che alcuni parametri dell’elemento TON (On Delay) non sono
obbligatori e questo & indicato dal fatto che non presentato i “???” (tre punti interrogativi).

Figura 7: TON: parametri obbligatori e non.
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10.3 Categorie degli elementi

Le categorie degli elementi LADDER disponibili per comporre la rete LADDER sono:

Contact Elements:

elementi di contatto;

Coil Elements:

elementi con bobine di contatto;

Comparison Function:

confronto tra variabili;

Device Functions:

funzioni relative ai device;

Counter Functions:

elementi contatori;

Timer Functions:

temporizzatori;

Table functions:

funzioni su array;

Bitwise Functions:

operatori sul singolo bit;

Boolean Functions - Bitwise:

operatori binari a bit;

Boolean Functions - Logical:

operatori binari su variabili;

Math Functions:

operatori matematici;

Trigonometric Functions:

operatori trigonometrici;

Edge Functions:

Funzioni di trigger;

Bistable Functions:

Funzioni di set/reset;

Selection Functions:

selettori, multiplexer, limitatori.

10.4 Commenti

Nella rete LADDER ¢ possibile utilizzare una riga di caselle per poter inserire dei commenti. Per inserire un commento si deve
selezionare del menu la voce Edit > New Element > Comment.
Ogni commento puo essere composto da un titolo e da un testo.

10.5 Jump e Label

Nella struttura Ladder € prevista la possibilita di saltare ad una label in modo che il programma possa saltare delle parti
gravose di programma quando non & neccessario eseguirle. Per inserire I'elemento di jump si deve selezionare dal menu la
voce Edit > New Element > Jump. Le proprieta di questo elemento consistono nel specificare I'etichetta associata al rung a
cui saltare. Per inserire I'etichetta a cui saltare si deve agire al solito modo selezionando dal menu la voce Edit > New
Element > Label. Naturalmente non ci possono essere etichette (label) con lo stesso nome nella stessa unita (Figura 8).

| Figura 8: Elemento di salto (JUMP) alla etichetta (LABEL) ETIC. |

44/94



QVIEW 6.0

i

Usit: [LADDZR | >] UniaLADDEF
AT R R g e ) e D B
1| #darcia [ ump

b | R ETIC
1 g
2| :

P ETIC >

3|

E’ possibile inserire anche I’elemento “Jump end” per saltare alla fine dell’unia direttamente senza bisogno di etichette (Figura
9).

Figura 9: Elemento di salto alla fine (JUMP END).
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10.6 Movimento delle righe LADDER

Nella struttura Ladder & prevista la possibilita di muovere parti di programma verso |'alto e verso il basso, in modo da
consentire al programmatore di inserire linee di programma non previste. Per muovere una linea si deve selezionare un rung
presente e selezionare tramite le voci del menu Edit > Move Rows Up o Edit > Move Rows Down.

Una volta terminato il task ladder, esiste la possibilita di compattare le linee di programma in modo di non lasciare spazi vuoti
con il comando di Edit > Compact Rows.

10.7 Drag & Drop degli elementi LADDER

Dalla parola stessa si intuisce che il comando serve a trascinare (drag) e posizionare (drop) uno o pil elementi ladder tramite
mouse dopo averli opportunamente selezionati. Selezionando uno o pil elementi ladder e tenendo premuto il pulsante di
sinistra del mouse sulla selezione, la selezione cambia colore ed il cursore del mouse cambia forma. E possibile in queste
condizioni spostare la selezione. Durante lo spostamento della selezione, compare, nella status bar in basso a sinistra il
messaggio: “Placing mode for drag and drop action”. Come per il comando Paste si possono presentare le seguenti situazioni:

- Drag & Drop eseguito in un'area libera da altri elementi ladder:
Una volta piazzato il riquadro, se si rilascia il pulsante del mouse, il riquadro colorato sparisce e I'elemento o gli elementi
selezionati vengono inseriti in editor.

- Drag & Drop eseguito sopra o nell'area di altri elementi ladder:

come precedentemente descritto, una volta piazzato il riquadro, se si rilascia il pulsante del mouse, il riquadro colorato sparisce
e viene visualizzato un box di messaggio che chiede di confermare o annullare I'operazione. Confermando I'operazione
I'elemento o gli elementi vengono inseriti nella rete sottostante operando automaticamente tutti i collegamenti necessari per
permettere una corretta compilazione del risultato finale.

10.8 Elementi LADDER obsoleti

Gli “Obsolete elements”, sono elementi ladder utilizzati dai programmatori, ma che sono stati successivamente dichiarati
obsoleti da QEM in qualita di fornitore e manutentore della libreria degli elementi ladder.

Generalmente, un elemento ladder pué venire marcato come obsoleto se € stato sostituito da un'equivalente elemento pid
aggiornato, al quale per esempio, € stata aumentata I'efficienza del codice interno.

L'elemento obsoleto & sempre rimpiazzabile da un'equivalente elemento della libreria ladder in uso. In un progetto che utilizza
degli elementi LADDER obsoleti essi sono riconoscibili dal fatto che vengono visualizzato con un colore di backgroud giallo (per
default). La presenza di elementi obsoleti nel programma & facilemente constatabile dalla presenza della voce Edit > New
Elements > Obsolete Elements e dalla cartella “Obsolete Elements” nella libreria degli elelenti (Figura 10).

| Figura 10: Cartella “Obslete Elements” |
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Nelle impostazioni Options > Program Setup... > Ladder Editor ¢ possibile modificare le impostazioni di default relative
agli elementi ladder obsoleti.

10.9 Sostituzione degli elementi obsoleti

La funzionalita di sostituzione degli elementi obsoleti (Sobstitute Obsolete element) ¢ stata inserita per operare la
sostituzione di un elemento obsoleto inserito nella rete ladder, con un corrispondente elemento sostitutivo.

La funzionalita € attivata dalla voce di menu Edit > Sobstitute Obsolete Element. Questa funzione ¢ attivata se il cursore
dell’editor ladder € posizionato sopra un'elemento obsoleto sostituibile.

Una volta sostituiti, gli ex elementi obsoleti cambiano il loro colore di background uniformandosi con gli elementi non obsoleti.
Utilizzando la voce di menu Edit > Sobstitute All Obsolete Elements si ha la possibilita, in una sola passata, di sostituire su
tutto il progetto (tutte le unita ladder) di tutti gli elementi ladder obsoleti. Una volta avviata questa procedura si ricercano
inizialmente gli elementi ladder obsoleti, appare il messaggio:

Searches for obsolete elements in progress...
Questo messaggio viene seguito da:

No obsolete elements to substitute

se non ci sono elementi obsoleti, oppure

There are obsolete ladder elements...

A questo punto ¢ possibile scegliere di avviare la sostituzione completa o di abbandonare I'operazione. Una volta completata la
sostituzione appare il messaggio:

All obsolete elements are substituted!
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11. Multitasking

Il multitasking & la capacita di un sistema di gestire I'esecuzione contemporanea di diversi compiti.

Un progetto realizzato in QCL e ladder & formato da un insieme di unit o tasks (in italiano compiti, appunto). Il multitasking
implementato nel sistema QMOVE & chiamato di tipo cooperativo, nel senso che I'esecuzione delle istruzioni passa da un task
ad un altro solamente quando, nel task in esecuzione, viene incontrata una particolare istruzione

WAIT < condizione >.

Questo e vero per i task scritti in codice QCL, mentre per i task sviluppati in ladder il passaggio al task successivo avviene dopo
|'ultima istruzione. La CPU smette di esequire il codice di un task quando il task stesso viene messo in attesa tramite la
istruzione WAIT.

Si schematizza il cosiddetto ciclo di tasks nella figura 1. Ogni task del progetto deve quindi poter cooperare con gli altri task
mettendosi in uno stato di attesa del verificarsi di una condizione e quindi nel frattempo passare ad eseguire gli altri task. Per
esempio, un task che ha il compito di eseguire un posizionamento di un asse deve aspettare che I'asse arrivi alla quota target
prima di continuare con altre operazioni. Nel frattempo, quindi, la CPU potra eseguire altre istruzioni prgrammate in altre unit.
Al momento dell’accensione I'ordine con cui vengono eseguiti le unit presenti & quello dichiarato nella finestra UNIT MANAGER
in QVIEW solo che il primo task eseguito ¢ il secondo in lista poi si procede fino all’'ultimo e quindi si esegue per ultimo il primo
in lista.

Figura 1: esecuzione task (condizione iniziale).
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Figura 2: esecuzione task (flusso operativo).
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Oltre all’esecuzione del codice, la CPU si occupa di eseguire contemporaneamente i device. La trattazione dei device &
rimandata al relativo capitolo; in breve, sono degli strumenti che forniscono delle funzionalita, richiamabili dal codice QCL o
Ladder, per realizzare le operazioni piu comuni che si incontrano nel campo dell’automazione industriale.

11.1 Struttura standard di un task QCL

Ogni task inizia la sua esecuzione dalla prima riga di codice. Il controllo poi passa al task successivo quando si incontra nel
codice un’istruzione WAIT (Figura 3).

| Figura 3: flusso del programma (condizioni iniziali). |

47/94



QVIEW 6.0

Codice
Taek 00

!

WAL | €R3ndEonGs [ e— 0 |3

L.

Quando il controllo ritorna al task in questione esso riprende |'esecuzione del codice dal punto in cui I'aveva interrotta solo se la
condizione posta subito a destra della parola chiave WAIT & vera altrimenti esegue nuovamente un cambio task, come e
schematizzato nella figura 4.

Figura 4: flusso del programma (condizione di cambio task).
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Puo succedere quindi che se in un task esiste un WAIT la cui condizione non & mai verificata il codice successivo a tale WAIT
non venga mai eseguito.

In ogni unita il codice QCL viene eseguito fino alla fine. Per fare in modo che questo codice venga ripetuto continuamente si
deve inserire un salto incondizionato dalla fine all'inizio del modulo. Ogni task, normalmente, ha una dotazione minima di
codice QCL del tipo:

[< declaration code >
[< initialization code >]
MAIN:
< operative code >
WAIT 1
JUMP MAIN
END
Il codice di inizializzazione presente prima del MAIN viene eseguito una sola volta in fase di accensione, mentre tutto quello che
sta tra MAIN e JUMP MAIN viene eseguito ciclicamente. Se in un qualsiasi task non fosse presente I'istruzione JUMP MAIN, il task
arriverebbe alla fine - END - paralizzando l'intero ciclo di multitasking. La CPU evidenzia che il ciclo & bloccato perennemente in

un task attraverso il segnale di Watchdog Active (in QVIEW Monitor > CPU).
L'istruzione WAIT 1 & necessaria per assicurare il cambio di task.

11.1.1 Esempio di SUSPEND

Se si inserisce nel task3 questa istruzione
Task2.SUSPEND

il task2 viene sospeso e non verra pil eseguito.
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Task2
Taskl Task2 Taskl

Task3 Taskd

Task2.SUSPEND

11.1.2 Esempio di RESUME

Se, per esempio, nel task4 la CPU esegue l'istruzione

task2.RESUME

la unit task2 viene riammessa nel ciclo di multitasking e il codice contenuto in essa riprende a funzionare.

Task?
Task1 ' Taskl Task2

Task3 Task4d Task3 Task4

Task2. RESUME

11.1.3 Esempio di RESTART

L'istruzione RESTART applicata ad una unit fa ripartire I'esecuzione del codice dalla prima istruzione della unit stessa. Per
esempio I'ordine di esecuzione delle istruzioni contenute in un task sono schematizzate nella figura seguente:
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Taskl: first execution

< Initialization code >

d

f'u"iF'n.IN.

~

Taskl: other executions

—~

4

< |nitialization code >

- MAIN: oo
< pperativp code > < operativlp code >
WAIT 1 - — WAIT 1
JUMP MAIN JUMP MAIN
END EMD

\\4 \4
Se nello stesso task o in un altro presente nel progetto la CPU esegue l'istruzione

taskl.RESTART

la prossima esecuzione del codice contenuto nella unti taskl riprende come se fosse la prima esecuzione (first execution).

11.2 Unita a tempo

Puo succedere che nella stesura di un programma si debbano gestire eventi a scadenza di tempo fissa e ripetibile. Essendo che
il sistema multitasking cooperativo non ha un tempo di ciclo ripetibile, sono state inserite le unit a tempo che sono attivabili
selezionando I'apposita casella nella unit property e dichiarando la base tempi da utilizzare.

Figura 1: dichiarazione di una unit a tempo
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Festione Jace empi pel :
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JUNP MATH
END
& UCL ™ Inbaerupt | |17 Hierg E3ae | ivemnt Loe I j
 Ladtes || Nomdl || (aing=cge | I Sevicermoe
| = 1me Tive Enecime) [IL =

Le unit a tempo sono prioritarie rispetto alle unit normali. Si deve porre attenzione al fatto che il codice inserito in una unita a
tempo (QCL o LADDER che sia) non impieghi pil tempo per essere eseguito del tempo di ripetizione impostato.

Nel caso questo succeda alcune ripetizioni del codice vengono “perse” (cioé non eseguite) e la CPU segnala tale evento con
una stato di “Time task lost”. Questo si puo vedere nella finestra CPU Monitor. Altra particolarita di questo tipo di unita & che
non possono essere inserite le istruzioni di WAIT, per cui il codice contenuto deve essere eseguito in un solo ciclo.

Ci possono essere al massimo 7 unita a tempo per ogni progetto.
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11.3 Unita in interruzione

Puo succedere che nella stesura di un programma si debbano gestire eventi provenienti da un ingresso in interruzione
(tipicamente fotocellule o sensori di prossimita). Per assolvere a questa funzione sono state inserite le unita in interrupt che
sono attivabili selezionando I'apposita casella nella unit property e dichiarando la linea di interruput ed il fronte di attivazione.

Figura 2: dichiarazione di un task in interruzione
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Le unita in interruzione sono prioritarie rispetto alle unita normali e rispetto alle unita a tempo, e non possono essere inserite le
istruzioni di WAIT, per cui il codice contenuto deve essere eseguito in un solo ciclo. Per non sovraccaricare la CPU con le
interruzioni e stato inserito il controllo che se prima non si & completata I'esecuzione del codice di interruzione, il sistema non
abilita la linea di interrupt, per cui in nessun caso si possono accodare pilu interruzioni provenienti dalla stessa linea.

Le unita in interrupt possono essere scritti sia in QCL che in Ladder.

Ci possono essere al massimo 3 unita in interruzione per progetto.
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12. Device

Il termine “device” identifica una categoria di dispositivi software atti a svolgere attivita di supporto o controllo (pit 0 meno
complesse), semplificando operazioni e procedure proprie dell’automazione industriale.

Per esempio, un device pud gestire un posizionatore di tipo CNC con uscita analogica +/-10V, rendendo disponibili tutte le
funzioni, i comandi ed i parametri necessari alla corretta gestione dei posizionamenti (ricerca di home, comandi per la
movimentazione manuale, parametri di velocita, tempo di inversione, ...).

| device dispongono di proprie funzioni, variabili, comandi e parametri; I'utente ha la possibilita di configurarli ed inserirli
all'interno del proprio progetto, in modo che uno o pil device diventino parte integrante dell’applicativo sviluppato.

| parametri sono delle variabili che permettono di configurare il funzionamento del device (ad esempio la velocita di
posizionamento, il conteggio, ecc.):

<device name>.<parameter device>

I comandi fanno eseguire al device determinate funzioni (ad esempio START, STOP, ecc.):

<device name>.<command name>

La lista dei device interni disponibili in un certo modello di QMOVE ¢ inserita nei manuali d’installazione e manutenzione relativi
alla CPU utilizzata.

12.1 Dichiarazione dei Device

| La sintassi per la dichiarazione dei device viene trattata approfonditamente nella documentazione dei device. |

L'utilizzo di un device deve essere dichiarato all’interno del file di configurazione oppure nella parte riservata alle dichiarazioni
di ogni unit. La sintassi della dichiarazione varia a seconda del device (interno o esterno).

12.1.1 Dichiarazione device

Per la dichiarazione del device interno, nel file di configurazione deve essere inserita la parola chiave INTDEVICE.
Per ulteriori informazioni fare riferimento alla documentazione relativa ai device interni.

12.2 Utilizzo dei devices

In questo capitolo si daranno delle informazioni preliminari per un corretto utilizzo dei devices interni. E indispensabile
comunque completare cio che segue con la documentazione specifica fornita per ognuno dei devices.

12.2.1 Tempo di campionamento

Come abbiamo gia detto, nel capitolo dedicato al multitasking, una delle caratteristiche peculiari dei devices ¢ il tempo di
campionamento (Tc) che stabilisce ogni quanto tempo viene eseguita la gestione del device da parte della CPU.

Vediamo quali sono i criteri generici nella scelta dei tempi di campionamento. Solitamente un tempo piccolo permette al device
di venire eseguito molto frequentemente e quindi di poter reagire velocemente alle azioni esterne (es.: miglior regolazione
degli assi). Durante I'esecuzione del codice QCL un accesso in scrittura al device o un comando viene processato dopo un
tempo massimo pari al tempo di campionamento. Questo fa si che piu piccolo & Tc, minore ¢ il ritardo di esecuzione del device.
Nel grafico di figura 1 si da una esemplificazione di quanto detto.

Figura 1: ritardo aggiornamento device.
! Comande  Aggiornemento '
device device |
| |
] |
Ritardo
m-1)T nic (n+1)7E

La scelta dei tempi di campionamento per i device utilizzati nel progetto che si sta realizzando deve essere fatta con le
opportune attenzioni. Una domanda che il lettore si sara posto ¢ la seguente: “Perche non posso scegliere come tempi di
campionamento il valore minimo consentito per ognuno dei device?”. In effetti in tal modo le prestazioni sarebbero le massime.
Questa scelta perd non & sempre possibile.
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La CPU riserva una parte della sua risorsa di calcolo per la gestione dei devices utilizzati nel progetto. Ogni device ad ogni
campionamento impegna una parte di questa risorsa. Per determinare e stimare I'utilizzo della risorsa consideriamo che la CPU
ad ogni millisecondo mette a disposizione una risorsa pari a 100. Nella documentazione relativa ai firmware si puo’ trovare la
percentuale di risorse che ogni device utilizza in un istante di campionamento. La CPU pu0 gestire nello stesso campionamento
pil devices e la risorsa occupata complessivamente e la somma delle percentuali relative ad ogni devices. Nella scelta dei
tempi bisogna evitare che in qualche campionamento la risorsa complessiva superi il valore 100%. Automaticamente la CPU
sfasa I'esecuzione dei device per evitare di superare il limite massimo della risorsa di calcolo disponibile.

Il grafico di figura 2 da una esemplificazione di quanto detto. Nell’esempio sono stati installati:

e un device OOPOS3 con tc=6msec.,
e un OOPOS3 con tc=30msec.,

¢ un device EANPOS con tc=2msec.
e un COUNTER3 con tc=3msec ed un
CAMMING3 con tc=1msec.

Figura 2: impegno risorse CPU per gestione device interni.
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12.2.2 Comandi consecutivi e loro priorita

Un comando ad un device non viene elaborato subito dalla CPU ma al successivo tempo di campionamento, senza per questo
che la sequenza delle successive istruzioni QCL venga interrotta. Per questo motivo il device potra trovarsi a processare nello
stesso istante di campionamento pill comandi, ed in questo caso la gestione del device non terra conto della sequenza con cui
tali comandi sono stati dati ma li processera secondo un ordine interno di priorita. Tale priorita e specificata nella
documentazione relativa ad ogni device.

Quando si vuole assicurare la sequenza con cui i comandi sono stati inseriti nella stesura del codice QCL, bisogna porre delle
istruzioni di WAIT e come condizione uno stato del device. In tal modo I'istruzione WAIT attende |'esecuzione del comando
prima di eseguire I'istruzione successiva.

12.2.3 Comandi complementari

Esistono dei comandi che sono tra loro complementari e cioé che producono ognuno I'effetto inverso dell’altro. Se ad un
campionamento il device si trova ad eseguire alcuni comandi fra loro complementari, risulta avere effetto solamente I'ultimo
della sequenza. Anche in questo caso per assicurare I'esecuzione dei due comandi fare riferimento al paragrafo “Comandi
consecutivi e loro proprieta”.

12.3 Gruppi di device
Nella sezione INTDEVICE & possibile definire un gruppo di device attraverso le parole chiavi DEVGROUP e ENDDEVGROUP.
Esempio:

DEVGROUP Assi
X ANPOS2 4 3.CNTO1 1 3.INP19 X.X 3.ANO1
Y ANPOS2 4 3.CNT02 2 3.INP18 X.X 3.AN0O2
ENDDEVGROUP

| device all'interno di un gruppo sono sottoposti a due vincoli:

1. Il loro tempo di campionamento deve essere lo stesso;
2. La somma dei loro tempi di esecuzione non deve superare il massimo tempo di esecuzione in un
campionamento.
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La definizione di un gruppo permette di garantire I'esecuzione di tutti i device che ne fanno parte nello stesso istante di
campionamento. E' una funzionalita riservata per particolari applicazioni di motion control.
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13. Ambiente Qview

In questo capitolo verranno descritti i vari menu e comandi di QVIEW. Per I'approfondimento di alcune funzionalita proprie
dell’ambiente Windows (Apri, Salva, ...) si imanda alla documentazione del sistema operativo.

13.1 Barra degli strumenti

La barra degli strumenti & composta da una serie di icone che ripropongono le funzionalita dei comandi principali (o di uso
frequente).
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13.2 Barra di stato

La barra di stato € composta da quattro sezioni distinte.

La prima sezione a sinistra & dedicata alla visualizzazione del valore della variabile selezionata. E' sufficiente cliccare sul tasto
destro di una variabile o di un parametro di un device per leggere il suo valore in questa sezione (naturalmente bisogna che il
collegamento seriale sia attivo). La seconda sezione da sinistra visualizza la posizione del cursore (riga e colonna) e la modalita
di scrittura (INS = inserimento di testo e OVR = sovrascrittura testo) (Figura 1).

La terza sezione da sinistra visualizza lo stato della porta seriale di comunicazione tra PC e CPU: stato della porta (No
connection o Connected with:...), protocollo di comunicazione in uso e velocita di trasmissione (Figura 2).

La quarta sezione pil a destra visualizza i messaggi “Match OK” o “No Match” quando la comunicazione seriale e attiva e il
progetto aperto ¢ lo stesso di quello presente nella CPU oppure e diverso, rispettivamente.

Figura 1: seconda sezione da sinistra: posizione cursore.

e

2] Col47 INS

Posizione cursore
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Modalitz di
scritture

Figura 2: terza sezione da sinistra: stato e parametri porta di comunicazione seriale.
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13.3 Menu File

Contiene i comandi per la gestione dei progetti e dei files che li compongono.
13.3.1 New Project

Permette di creare un nuovo progetto. Inizialmente viene richiesto il nome da assegnare al progetto (Figura 1).

Viene quindi aperta automaticamente la finestra “Project Information” (Figura 2) per inserire i dati del progetto che si intende
realizzare. Questa tabella ha lo scopo di raccogliere una serie di informazioni, essa puo essere compilata anche in un secondo
momento (in ogni caso non ¢ obbligatorio compilarla).

Figura 1: inserimento del nome del progetto.
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Figura 2: finestra con le informazioni di progetto.
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13.3.2 Open Project

Permette di aprire un progetto esistente (Figura 3).

| Figura 3: apertura di un progetto.
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E’' possibile aprire i progetti realizzati con versioni precedenti di Qview selezionando le diverse estensioni da “Tipo file".

13.3.3 Save Project
Permette di salvare le modifiche apportate al progetto in uso.
13.3.4 Save Project As

Permette di salvare una copia del progetto in uso (comprese le eventuali modifiche apportate) (Figura 4).

Figura 4: salvataggio di un progetto con un altro nome.
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13.3.5 Close Project

Permette di chiudere il progetto in uso.
13.3.6 Add Unit

Permette di aggiungere una nuova unita al progetto in uso.
Le nuove unita possono essere:

¢ Configuration Unit: inserisce la unit di configurazione. Non ¢ abilitato se nel progetto ¢ gia presente una
unit di configurazione.

¢ QCL Unit: inserisce una nuova unit (task) in linguaggio QCL

e Ladder Unit: inserisce una nuova unit (task) in linguaggio Ladder

e Document Unit: inserisce una nuova unit document (documento di testo per la raccolta di commenti,
specifiche, note ...).

Questa nuova unit verra aggiunta in coda alla lista delle unit gia presenti.

13.3.7 Insert Unit
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Permette di inserire una nuova unit al progetto in uso.
Le nuove unita possono essere le stesse elencate per il comando Add Unit.

Questa nuova unit verra inserita nella lista appena sopra alla unit selezionata.
13.3.8 Creazione di una unit di configurazione

Ogni volta che viene creato una nuova unit di configurazione con i comandi “Add unit” o “Insert unit”, appare la finestra “Unit
property” (Figura 5).

Figura 5: intestazione dell’unit di configurazione.
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In questa finestra & possibile assegnare un nome all’unit e una breve descrizione della unit. Una volta confermato con Ok, la
unit di configurazione viene aggiunta alla lista delle unit e viene aperta la finestra di editor per iniziare a modificarla.
In un progetto deve esistere una sola unit di configurazione.

13.3.9 Creazione di una unit QCL o LADDER

Ogni volta che viene creato una nuova unit QCL o LADDER con i comandi “Add unit” o “Insert unit”, appare la finestra “Unit
property” (Figura 6, 7).

Figura 6: intestazione dell unita QCL.
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Figura 7: intestazione delle unit LADDER.
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In questa finestra & possibile assegnare un nome alla unit e una breve descrizione della unit.

Una volta confermato con Ok, la unit QCL o LADDER viene aggiunta alla lista delle unit e viene aperta la finestra di editor per
iniziare a modificarla.

Nelle finestre “Unit property” & possibile specificare se la unit (QCL o LADDER) & una unit

¢ normale;

¢ in interrupt: si deve specificare il fronte (Rising Edge: fronte di salita, Falling Edge: fronte di discesa)
dell'impulso che avvia I'interrupt e la linea di interrupt utilizzata (Interrupt Line);

¢ a tempo: si deve specificare ogni quanto tempo si deve ripetere il codice inserito nell’'unita (Time Exec.).

13.3.10 Creazione di un unit di documentazione

Le unit di documentazione sono utilizzate dal programmatore per scrivere appunti, note, particolari di funzionamento. E’
possibile utilizzare queste unit solamente in modalita di testo.

13.3.11 Remove Unit

Permette di rimuovere la unit selezionata.

Figura 8: selezione della unit da rimuovere.

®  FIRSTAPP Unit di con®gu-adone

l Task 0 [ a5« pat rcremento Yanadi

Prima dell’eliminazione della unit, il programma chiede se si vuole esportare la unit prima di rimuoverla; in caso contrario, la
unit verra persa.

Figura 9: richiesta di esportazione unit.
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13.3.12 Import Unit

Permette di importare una unit precedentemente esportata anche da un altro progetto (Figura 10).
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Figura 10: Importazione di una unit.
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E’ possibile selezionare I'alternativa “Add unit...” o “Insert unit...” per importare la unit in coda alla lista o sopra la unit
selezionata in quel momento.

13.3.13 Export Unit

Permette di esportare una copia della unit di progetto selezionata, per poterla trasferire ad un altro progetto. La copia originale
rimarra nel progetto stesso. La unit verra esportata nella stessa directory del progetto aperto. La unit verra esportata come un
file con estensione unt.

Figura 11: Conferma di esportazione.

W INFIRMATION W

Metzage code : 127
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Press OK butlon to continue

13.3.14 Export Unit As

Permette di esportare una copia dell unit di progetto selezionata rinominando la unit. La copia originale rimarra nel progetto
stesso.

Figura 12: richiesta di esportazione unit con rinomina del nome.

T —— T
Sabva pe | 3 Fisthpp =| EI Ej gl IHEI

[[ETEN N DD ULE - U] | Save
Sahva come:  [Fiec UM | - Aol I

13.3.15 Unit Property

Permette di modificare le proprieta della unit selezionata. In particolare & possibile impostare il comportamento Runtime della
unit in questione, cioé la modalita di esecuzione della unit una volta che verra trasferita nella CPU del Qmove. Le unit possono
avere i seguenti comportamenti:
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Normal Fino al limite massimo consentito (totale massimo di unit: 65535).
Conferisce alla unit un comportamento Runtime ciclico (vedere il capitolo relativo al multitasking).

Interrupt Massimo tre unit per progetto.

Conferisce alla unit un comportamento Runtime determinato da eventi esterni all'apparecchiatura (linee di interrupt hardware).
Si pu6 determinare se I'esecuzione della unit sara attivata sul fronte di salita o discesa del segnale entrante ed il numero della
linea hardware ad essa collegata, impostabile da 1 a 8.

Time Massimo sette unit per progetto.

Conferisce alla unit un comportamento Runtime determinato dallo scadere di un tempo prefissato, interno all'apparecchiatura.
Il predetto tempo ¢ regolabile in un range da 1 a 999 millisecondi. Nell' inserimento di una nuova unit a tempo, il tempo
proposto e di 100ms.

Figura 13: modifica delle proprieta di una unit.
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Aprendo la finestra “Unit property” (Figura 13) € possibile rinominare un unita precedentemente introdotta cambiando il suo
Unit Name.

13.3.16 Import Module As Unit

Permette di importare una unit realizzata con le vecchie versioni di Qview (*.mod). E’ possibile aggiungere la unit in coda alla
lista (Add Module as unit) oppure inserirla in una posizione intermedia sopra a quella selezionata (Insert Module as unit).

13.3.17 Export Unit as Module

Permette di esportare una o pil unita in un formato compatibile con le precedenti versioni del Qview (moduli per Qview 2.x e
Qview 3.x). Una volta selezionata questa funzione viene visualizzata la finestra di figura 14 dove & possibile selezionare quali
unita esportare (vengono elencate solo le unita non LADDER).

| Figura 14: esportazione delle unitd come moduli. |
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Urits To Export As Modules
patie st | |
CONFIG Questa & una urita & configur agione
MODULEL Uiritdh cor codice GO
DT Ficle el prcae affirsl g

Cancel

Per selezionare I'unita da esportare bisogna eseguire un doppio-click sull’'unita stella.
13.3.18 Export Symbols File

Permette di esportare il file simboli dal progetto per poter riallineare i simboli nel terminale.

Figura 15: esportazione simboli.
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13.3.19 Export Symbols File As ...

Permette di esportare il file simboli dal progetto, rinominandoli, per poter riallineare i simboli nel terminale.

Figura 16: esportazione simboli con rinomina.
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13.3.20 Export Binary File & Export Binary File As ...

Questa funzionalita € disponibile se la compilazione del progetto € andata a buon fine. Esso permette di esportare il file binario
(risultato della compilazione) utile per poter eseguire il download dell’applicativo nella CPU senza I'utilizo della comunicazione
seriale (per esempio trasferendolo alla CPU attraverso una Multi Media Card). E’ possibile esportare il file binario con lo stesso
nome del progetto (Export Binary File) oppure cambiando il suo nome (Export Binary File As...).
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13.3.21 Project Information ...

Permette di visualizzare una finestra (Figura 20) per I'inserimento delle informazioni specifiche del progetto.

Figura 17: visualizzazione informazioni sul progetto in uso.
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In questa finestra sono presenti delle cartelle che suddividono le informazioni di progetto per argomento. Alcune informazioni
sono contrassegnate con un asterisco per indicare che sono obbligatorie per una completa informazione sul progetto. Se alcune
di queste informazioni obbligatorie non vengono inserite, periodicamente appariranno dei messaggi che avviseranno il
programmatore di questa mancanza (per disabilitare questi avvisi si veda Menu Options - Program Setup). In questa
finestra esiste il tasto “Checksums” che inserisce in tabella i codici checksum del progetto automaticamente.

13.3.22 Print

| Il comando é disponibili solo selezionando una finestra di editor. |

Permette di accedere ad un finestra “Print Manager” tramite la quale € possibile stampare una parte o tutto il progetto con
alcune possibilita di configurazione della stampa stessa. In figura 18 viene mostrata questa finestra dove nel riquadro basso
appare la lista delle unit che compongono il progetto. Selezionando queste unita con il mouse ¢ possibile decidere quali
stampare. Nel riquadro in alto a sinistra si possono impostare dei settaggi generici sulla dimensione del font e sul numero di
copie da eseguire.

Nel riquadro in alto a destra € possibile configurare la stampa dei task LADDER dove si pu0 specificare:

e stampa della lista degli ingressi e uscite utilizzati nel task LADDER,;

¢ stampa delle variabili utilizzate nel task LADDER;

e stampa dei commenti inseriti nel task LADDER,;

¢ stampa con compattamento delle righe LADDER eliminando gli spazi vuoti;
e stampa dei numeri dei rung;

e numero di celle per linea da stampare.

Inoltre in alto a sinistra e possibile selezionare la stampa solo della parte dell unit evidenziata.

| Figura 18: selezione modalita di stampa. |
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13.3.23 Richiamo ultimi progetti aperti

E possibile richiamare direttamente gli ultimi 4 file aperti (Figura 19).

Figura 19: apertura progetti recenti.
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13.3.24 Exit
Chiude QVIEW chiedendo il salvataggio delle eventuali modifiche apportate al progetto in uso.

13.4 Menu Edit

| | comandi a seguire sono disponibili solamente quando é visualizzata un’unita con I’apposito editor.

13.4.1 New Element

Permette di inserire un nuovo elemento nella rete Ladder (deve essere visualizzata un’unita LADDER).
13.4.2 New Rung

Permette di inserire un nuovo rung nella rete Ladder (deve essere visualizzata un’unita LADDER).
13.4.3 Delete Rung

Permette di eliminare il rung selezionato nella rete Ladder (deve essere visualizzata un’unita LADDER).

13.4.4 Toggle Link

Permette di collegare in verticale due elementi ladder. Il collegamento viene fatto sempre verso il basso e nella parte sinistra
della cella selezionata (deve essere visualizzata un’unita LADDER).

13.4.5 Substitute Obsolete Element & Substitute All Obsolete Elements...

Permette di sostituire I'elemento o tutti gli elementi obsoleti. Per una descrizione pili completa si veda il capitolo “Editor
LADDER - Elementi LADDER obsoleti” (deve essere visualizzata un’unita LADDER).
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13.4.6 Element Properties...

Permette di modificare le variabili utilizzate all'interno dell’elemento LADDER selezionato (deve essere visualizzata un’unita
LADDER).

13.4.7 Undo

Permette di cancellare I'ultima modifica fatta.

13.4.8 Redo

Permette di annullare il comando di Undo e reinserire la modifica eliminata.

13.4.9 Cut - Copy - Paste - Delete

Per tagliare, copiare, incollare ed eliminare del testo o degli elementi.

13.4.10 Select All

Permette di selezionare tutto il testo o gli elementi contenuti in una finestra di editor.
13.4.11 Compact Rows

Permette di compattare le righe di codice Ladder nel minor numero di celle possibili eliminando le righe vuote (deve essere
visualizzata un’unita LADDER).

13.4.12 Move Rows Up

Permette di spostare in alto una riga di codice ladder (deve essere visualizzata un’unita LADDER).
13.4.13 Move Rows Down

Permette di muovere in basso una linea di codice Ladder (deve essere visualizzata un’unita LADDER).

13.4.14 Find

Ricerca la parola inserita in funzione dei criteri di ricerca selezionati (Figura 20).
Criteri di ricerca

e Search in Current Unit: ricerca solo nell’unita selezionata.

e Search in All Units: ricerca in tutte le unita del progetto.

e Find Whole Word Only: cerca solo parole intere

¢ Match Case: cerca parole come digitato, rispettando maiuscole e minuscole.

Figura 20: finestra inserimento criteri di ricerca.
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13.4.15 Find Next

Una volta trovato un termine (comando Find), permette di continuare la ricerca dello stesso termine sul resto del documento (o
sulle altre unita), mantenendo inalterati i criteri di ricerca.
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13.4.16 Replace

Ricerca la parola inserita (Find What) con i criteri di ricerca impostati e la sostituisce con la nuova parola (Replace With)(Figura
21).

Criteri di ricerca

Search in Current Unit: ricerca solo nella unit selezionata;

Search in All Units: ricerca in tutti le unit del progetto;

Find Whole Word Only: cerca solo parole intere;

Match Case: cerca parole come digitato, rispettando maiuscole e minuscole.

Criteri di sostituzione

¢ Find Next: non esegue nessuna sostituzione ma inizia la ricerca della parola (Find What) nel resto del
progetto;

* Replace: sostituisce la parola cercata (Find What) con la nuova parola (Replace With);

¢ Replace All: sostituisce automaticamente tutte le parole (Find What) dell’intero progetto.

Figura 21: finestra inserimento criteri per ricerca e sostituzione.
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13.4.17 Go to ...

Sposta il cursore al numero di riga inserito (Figura 22).

Figura 22: inserimento numero di riga per spostamento cursore.
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13.4.18 Go to PC

Dal momento in cui I'esecuzione del progetto viene interrotta (per esempio per I'inserimento di un breakpoint), questo
comando visualizza la riga di programma alla quale si € verificata I'interruzione. In figura 23, il comando Go to PC visualizza
I'interruzione per I'inserimento di un breakpoint.

Figura 23: esecuzione programma interrotta da breakpoint.
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13.4.19 Next Unit / Previous Unit

Permette di spostarsi tra le unit del progetto.
13.4.20 Next Selected Unit / Previous Selected Unit

Quando fosse necessario spostarsi tra alcune unit del progetto ignorandone alcuni altri, selezionare uno per volta le unit da
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visualizzare e premere la barra spaziatrice. A fianco delle unit selezionate compare un punto rosso (Figura 24).
Con i comandi Next e Previous Selected Unit & possibile scorrere in avanti ed indietro solamente tra le unit selezionate.
Per rimuovere la marcatura, selezionare la unit e ripremere la barra spaziatrice; il punto rosso scompare.

Figura 24: selezione unit da analizzare.
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13.5 Menu: Project
Contiene i comandi la gestione dei progetti e dei dati contenuti nella CPU.
13.5.1 Compile

Converte il progetto in uso in un formato interpretabile dalla CPU. Il progetto potra essere scaricato nella CPU solo se la
compilazione si & conclusa senza errori (Figura 25).

Figura 25: finestra compilazione progetto.
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Nel caso di compilazione del progetto conclusa con errori, & possibile visualizzare sull’editor la riga di codice contenente I'errore
facendo un doppio click con il mouse sul messaggio fornita dalla finestra di compilazione.

13.5.2 Force Compile

La funzionalita ha lo scopo di indurre la compilazione forzata di tutto il progetto indipendentemente che esso sia gia stato
compilato o meno.

13.5.3 Ladder Network Checking

Permette eseguire un check della rete Ladder. Sul desktop appare la finestra del risultato della compilazione eseguita (Figura
26).

Figura 26: finestra compilazione rete ladder.
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13.5.4 View compilation result
Visualizza o nasconde la finestra del risultato dell'ultima compilazione (Figura 24).

13.5.5 Download

| Questo comando e disponibile solo dopo I'attivazione della comunicazione seriale PC - QMOVE. |

Permette di scaricare nella CPU il progetto compilato. Le varie fasi del download vengono visualizzate in una finestra dedicata
(Figura 27).

| Figura 27: esito download. |
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13.5.6 Backup data

| Questo comando e disponibile solo dopo aver eseguito il download dell’applicativo. |

L'applicativo che I'utente trasferisce nella CPU ¢ costituito da informazioni non mutabili ed informazioni mutabili.

Informazioni non mutabili Sono le informazioni dell’applicativo che non subiscono variazioni, quali istruzioni QCL, simboli
utilizzati nel progetto, titolo applicativo, ...

Informazioni mutabili Sono le informazioni che indicano situazioni di funzionamento dell’applicativo quali aree dati per
devices interni, valore variabili, array system, contenuto datagroup e dati il cui valore viene modificato durante il
funzionamento (tutti i dati applicativo).

Il backup € un comando che consente di creare una copia di sicurezza di tutti i dati mutabili, registrandola all’interno della
memoria interna non-volatile. L'utilita di questa operazione deve essere vista nella possibilita di ripristinare tutta la
parametrizzazione esistente in un determinato momento. Poiche i valori vengono copiati in una memoria non-volatile, esiste la
massima sicurezza nel dispositivo di memorizzazione (Figura 28).

Condizioni che permettono I'esecuzione del comando di backup:

e CPU in stato di READY.

¢ Applicazione che non utilizzi ram per un valore superiore al limite di backup; la quantita di ram disponibile
viene definita al momento dell’acquisto scegliendo tra i tagli di memoria disponibili.

¢ La somma dello spazio occupato dai dati mutabili e non mutabili non deve superare la dimensione della
memoria non-volatile.

Se il backup, eseguito da terminale operatore, impiega un tempo maggiore del timeout del terminale, interviene I'errore di
timeout error nella comunicazione seriale tra CPU e terminale.

Figura 28: richiesta conferma procedura di backup.
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13.5.7 Restore data

| Questo comando e disponibile solo dopo aver eseguito il download dell’applicativo. |

L'applicativo che I'utente richiama dalla CPU & costituito da informazioni non mutabili ed informazioni mutabili.

Informazioni non mutabili Sono le informazioni dell’applicativo che non subiscono variazioni, quali istruzioni QCL, simboli
utilizzati nel progetto, titolo applicativo, ...
Questi dati sono memorizzati in flash memory.

Informazioni mutabili Sono |le informazioni che indicano situazioni di funzionamento dell’applicativo quali aree dati per
devices interni, valore variabili, array system, contenuto datagroup e dati il cui valore viene modificato durante il
funzionamento (tutti i dati applicativo).

Questi dati sono memorizzati in memoria tamponata.

Il comando restore consente di ripristinare tutte le informazioni mutabili con quelle presenti al momento del backup (Figura 29).
Il contenuto del backup viene cancellato durante la procedura di download; infatti non ha alcun senso copiare i valori dei dati
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mutabili di un applicativo su un applicativo diverso. Condizioni che permettono I’esecuzione del comando di restore:

¢ Deve essere stato fatto precedentemente un backup.
¢ CPU in stato di READY o ERROR.

Figura 29: richiesta conferma procedura di restore.
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13.5.8 Save Data...

| Questo comando é disponibile solo dopo aver eseguito il download dell’applicativo. |

Salva i dati presenti nella CPU (valori delle variabili ritentive) in un file .DAT; € possibile definire la directory di destinazione del
file (Figura 30).

Figura 30: salvataggio dati CPU su file.
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13.5.9 Recall Data...

| Questo comando e disponibile solo dopo aver eseguito il download dell’applicativo. |

Sostituisce i valori delle variabili ritentive presenti nella CPU con i valori delle stesse variabili archiviate in un file .DAT (Figura
31). La sostituzione interessa solamente le variabili in comune all’applicativo ed al file .DAT; se, per esempio, nella CPU sono
state aggiunte delle variabili successivamente all’archiviazione dei dati, queste non saranno interessate dalla sostituzione.

Figura 31: sostituzione dati CPU con file .DAT
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13.5.10 Convert Data...

| Questo comando & sempre disponibile. |
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Converte il file .DAT selezionato in un file di testo (.TXT) contenente il nome delle variabili ed il relativo valore. |l file di testo
viene generato all'interno della directory che contiene il file .DAT e gli viene assegnato lo stesso nome del file .DAT (Figura 32).

Figura 32: conversione file dati.
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13.5.11 Checksum View

| Questo comando e disponibile dopo I’apertura di un progetto. |

Confronta i checksums del progetto in uso con quelli dell’applicativo scaricato nella CPU (Figura 33), se sono gli stessi vuol dire
che la CPU contiene il progetto su cui sto lavorando. Le eventuali diversita vengono segnalate con i valori di checksum in rosso.

Vengono confrontati i seqguenti tipi di dati:

» Configuration: configurazione memoria utilizzata.

¢ Code: codice QCL generato dalla compilazione.

¢ Symbol: simboli delle variabili utilizzate. Dipende dall’elenco delle variabili e dal loro tipo.
e Source: contenuto delle unita

ATTENZIONE! La compilazione dello stesso progetto con due Qview di build diverse garantisce le stesse funzionalita, ma non
viene garantito che i codici checksum si mantengano uguali.

Figura 33: riepilogo e confronto checksum.
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La colonna CPU visualizza i valori presenti in CPU e rappresentanti il suo applicativo.
La colonna Project viene aggiornata all’apertura del progetto (se precedentemente compilato) e dopo ogni compilazione.

13.5.12 Project ID View

| Questo comando é disponibile solo dopo I'attivazione della comunicazione seriale PC - QMOVE. |

Visualizza il nome assegnato al progetto. Questo nome & stato definito nella finestra Project Information. Durante il download il
Project ID viene scaricato nella CPU con I'applicativo ed & poi visualizzabile tramite il comando Project ID View (Figura 34).

Figura 34: visualizzazione stringa progetto.
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13.6 Menu Debug

Contiene i comandi per I'esecuzione dell’applicativo scaricato nella CPU.
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13.6.1 Run

| Questo comando é disponibile dopo un download. |

Mette in esecuzione I'applicativo scaricato nella CPU..

13.6.2 Stop

| Questo comando e disponibile dopo un run. |

Interrompe I'esecuzione dell’applicativo residente nella CPU (i device continuano comunque a funzionare).

13.6.3 Restart

| Questo comando e disponibile dopo uno start o uno stop. |

L'esecuzione dell’applicativo viene interrotta e al RUN successivo il programma riparte dalla prima unit.

13.6.4 Reset

| Questo comando é disponibile solo dopo I'attivazione della comunicazione seriale PC - QMOVE. |

Cancella I'applicativo residente nella CPU. La cancellazione dei dati e definitiva; viene quindi richiesta la conferma al reset
dell’applicativo (vedi figura 35).

Figura 35: richiesta conferma procedura di reset progetto.
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13.6.5 Step

| Questo comando é disponibile solo dopo un download e selezionando la finestra di editor testo. |

Questo comando permette di eseguire il progetto in uso un passo alla volta; ad ogni step I'esecuzione del flusso di programma
avanza di un passo. Raggiunta l'istruzione di wait, la finestra di editor passa a visualizzare la unit successiva permettendo in
questo modo |'esecuzione del programma un passo alla volta su tutte le unit che compongono il progetto.

Una freccia verde sulla sinistra delle finestra di editor identifica la riga di programma che non & ancora stata eseguita (Figura
36). Nel caso di unita LADDER sara possibile eseguire un rung ad ogni passo.

Figura 36: esecuzione programma in modalita Step.
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13.6.6 Step Over

| Questo comando e disponibile solo dopo un download e selezionando la finestra di editor testo. |

Questo comando permette di eseguire il progetto in uso un’istruzione alla volta; ad ogni step I'esecuzione del progetto avanza
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di un’istruzione. Raggiunta l'istruzione di WAIT, I'’esecuzione del codice continua normalmente sulle altre unit fino a ritornare a
quella in uso riprendendo I’'esecuzione passo a passo.

Una freccia verde sulla sinistra delle finestra di editor identifica la riga di programma che ¢ stata eseguita (Figura 37). Nel caso
di un’unita LADDER sara possibile eseguire un rung ad ogni passo.

13.6.7 Toggle Breakpoint

Questo comando é disponibile solo dopo un download e selezionando la finestra di editor testo. |
E’ possibile inserire un massimo di 5 breakpoint. Vengono resettati allo spegnimento della CPU e con il download del progetto. |

Questo comando permette di inserire un breakpoint ovvero di identificare una riga di codice, raggiunta la quale, I'esecuzione
del programma si interrompe. E’ possibile definire pit punti di breakpoint. Selezionando una riga di codice sulla quale & stato
inserito un breakpoint, il comando Toggle breakpoint elimina il breakpoint. L’inserimento del breakpoint viene visualizzato sulla
sinistra della finestra di editor con un contrassegno rosso all'interno del quale viene visualizzata la sigla ST (Figura 37). E’
possibile inserire un breakpoint anche in una unit LADDER in corrispondenza di uno dei rung.

Figura 37: inserimento breakpoint.

B TasSE_00MOD

Fila: Ilﬁ"\,‘ar._JL sOL 1] las« par ncremento vamabile

TMARTHN:
ﬂ slProva - sll*r‘:va + 1 J
WAIT ]

JUMI MAZN
END

3 ] -J:I

13.6.8 Clear All

| Questo comando é disponibile solo dopo un download. |

Questo comando elimina da tutti i task tutti i breakpoint inseriti.

13.6.9 Watchpoint

Questo comando e disponibile solo dopo un download. |
E’ possibile inserire un massimo di 5 watchpoint. Vengono resettati allo spegnimento della CPU e con il download del progetto. |

Questo comando permette di interrompere I'esecuzione del progetto in uso alla soddisfazione di una particolare condizione; si
pud quindi parlare di breakpoint condizionato. Selezionando il comando watchpoint viene proposta la finestra di figura 38 che
visualizza le condizioni di interruzione del programma che sono state impostate.

e Add: permette di aggiungere una condizione di arresto del programma (Figura 39).
¢ Delete: elimina la condizione selezionata.
¢ Reset: elimina tutte le condizioni di arresto impostate.

Figura 38: elenco watchpoint.
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Figura 39: impostazione parametri di watchpoint.
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La finestra di figura 39, visualizzata alla pressione del tasto Add (Figura 38), permette di impostare la condizione di arresto del
programma.

e Watch Type: selezione la tipologia di variabili (Variables, 1/0, Arrays, Data Groups, Devices).

¢ Name: permette di selezionare la variabile appartenente al gruppo definito nella casella a scorrimento
Watch Type.

¢ Value: permette di inserire il valore della variabile selezionata al quale I'esecuzione del programma si deve
arrestare.

13.7 Menu Monitor
Contiene i comandi per la diagnostica del sistema QMOVE e dell’esecuzione di progetti.
13.7.1 Devices Panels

L'’ambiente Qview prevede che per i devices ci sia, oltre che alla lista di stati parametri comandi, un pannello che permetta
all’utilizzatore un semplice approcio con il devices stesso. vengono visualizzati il nome assegnato al device ed il tipo di device
(Figura 51).

Figura 51: elenco pannelli dei device.
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Selezionando un device (con il tasto ENTER o con doppio clic) viene proposta una finestra (Figura 52) all’'interno della quale &
possibile visualizzare i dati del device; per una spiegazione dei devices panel, fare riferimento all’apposito help.

| Figura 52: esempio di un pannello. |
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13.7.2 CPU MONITOR

La finestra CPU MONITOR fornisce una serie di informazioni generali riguardanti lo stato della CPU e le tempistiche relative
all'esecuzione del progetto. La finestra CPU Monitor Panel si compone di tre sezioni:

e GENERAL: informazioni generali sullo stato della CPU e i tempi di esecuzione dell'intero progetto.

e TASK INFO: informazioni relative ad ogni singola unit che compone il progetto.

e CPU’s oscilloscope: strumento che permette di determinare I'andamento nel tempo del valore di una o piu
variabili del progetto.

13.7.3 General

In questa finestra vengono fornite informazioni relative allo stato della CPU.

¢ Mode: visualizza lo stato della CPU (RUN, STOP, ... Err). In caso di errore viene visualizzato anche il tipo di
errore.

e System Time: visualizza il tempo reale di funzionamento dell’applicativo dal momento dell’accensione o
restart della CPU.

¢ Used CODE Memory: visualizza la percentuale di memoria impegnata dal codice.

e Used DATA Memory: visualizza la percentuale di memoria impegnata dai dati.

» Battery low: segnala lo stato di batteria tampone interna scarica.

¢ Watchdog Task: segnala che vengono impiegati pit di 200 ms per eseguire un task. Questa segnalazione
viene mantenuta fino allo spegnimento della CPU. Il progetto continua a funzionare correttamente,
tuttavia la segnalazione indica un’errata programmazione QCL.

e Backup OFF: segnala I'impossibilita di eseguire il backup (ad esempio perche viene impegnata una
percentuale elevata di DATA Memory).

e Time Task Lost: segnala che nell’esecuzione del programma non & stato eseguito una o piu volte un task a
tempo.

e Running time in ms: tempo di esecuzione dei task.

¢ Active Task: task in uso.

Time Task Lost: segnala che nell’esecuzione del programma non ¢ stato eseguito una o piu volte un task a

tempo.

o Wait State: segnala il raggiungimento dell’istruzione di wait (all’interno del task in uso).

* Breakpoint: segnala che il flusso del task attivo ha raggiunto un breackpoint e si & interrotto.

e Watchdog Active: segnala che il task attivo ha causato la segnalazione di Watchdog.

Si possono, inoltre, leggere i tempi MINIMUM TIME e MAXIMUM TIME che sono il minimo e massimo tempo impiegato per

eseguire il progetto.
Vi e inoltre un tasto di Reset Timing il quale azzera i due valori ed il Running time riabilitando il conteggio del tempo di

elaborazione.

| Figura 56: CPU general panel. |
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13.7.3.1 Task info

In questo menu possono essere controllati tutte le unit elaborati dal programma, e possono essere ricavate informazioni di
vario genere. Tutti le unit possono dare infomazioni sul tempo di esecuzione minimo, massimo ed attuale.

Per i task normali si possono avere inoltre informazioni relative al WATCHDOG. Quando viene segnalato un WATCHDOG per un
task significa che la CPU ha impiegato piu di 200ms per eseguire il suo codice senza mai avere eseguito nessun altro task
(questa & una anomalia che il programmatore dovrebbe risolvere).

Per tutti gli altri task si possono avere ulteriori informazioni relative a :

e TASK LOST: Indica che il task a tempo ha perso un evento.
e DEVICE ACCESS: Indica che il task ha eseguito un accesso a device e che questo non era aggiornato.
o INTERRUPT: Indica che un task a tempo e stato interrotto da un task in interrupt (Figura 57).

Figura 57: CPU general panel.
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Tutte le informazioni della videata precedente (Figura 57) possono essere visualizzate solo se i check-sum del programma in
CPU e su PC corrispondono, altrimenti, nella videata di Task Info verranno visualizzati solamente i task di programma senza
alcun’altra informazione (Figura 58).

Figura 58: CPU Task info.
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Nel caso di errori, i vari campi assumeranno il colore rosso, in caso contrario, i campi rimarranno di colore bianco.

13.7.3.2 CPU’s Oscilloscope

L'oscilloscopio permette di visionare nel tempo cio’ che accade alla CPU (Figura 59).

Figura 59: CPU Oscilloscopio.
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Se si vuole fare un’acquisizione si inserisce il Capture Time (S) e la scansione inizia continuando per il tempo impostato,
comunque non superiore ai 9999 sec.

Quando si lancia una acquisizione tutto il resto del Qview viene bloccato proprio per non togliere risorse a questa funzionalita.
L'acquisizione pu0 essere associata ad una variabile qualunque, tranne un datagroup, e I'acquisizione nel tempo puo essere
abilitata anche con macchina in funzione senza pregiudicarne il funzionamento in quanto il controllo non grava
sull’elaborazione.

L'acquisizione pu0 essere fermata in qualunque momento tramite la pressione del tasto Backspace.

Impostazioni per la memorizzazione:

CAPTURE TASK: Questo parametro determina in quale campo agire per effettuare la misurazione:

- Su tutti i task , se impostato come CPU CICLE TIMINGS , in questo modo possiamo vedere il tempo di ciclo di tutto il
programma (Min. Max. Run). - Su un task singolo, se impostato come task a tempo o ad interrupt, in questo modo possiamo
vedere il tempo di ciclo del singolo task seleziona to (Min. Max. Run). Naturalmente se il task selezionato risulta essere un task
normale il tempo di scansione che verra visualizzato sara’ quello di tutto il programma, questo particolare caso comungue
viene evidenziato con l'ausilio di un messaggio (Figura 60).

Figura 60: CPU Oscilloscopio Capture Task.
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CHART: Questa finestra serve per impostare al meglio le caratteristiche grafiche di visualizzazione ed i riferimenti relativi alle
misurazioni effettuate (Figura 61).

| Figura 61: CPU Oscilloscopio Chart. |
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Per conoscere il significato dei vari tasti basta posizionarsi sopra al tasto interessato con il cursore del mouse e comparira la
descrizione specifica.

Oltre alle misure delle tempistiche dei task € possibile monitorare I'andamento nel tempo di una variabile di riferimento che si
puo specificare nella casella “Reference variable” nella sezione Capture.

Se la variabile non esiste compare un messaggio di segnalazione, ma la registrazione viene compiuta ugualmente senza,
naturalmente, la variabile.

13.7.4 BUS

Questo comando é disponibile dopo I’apertura di un progetto esistente e I’apertura della porta di comunicazione seriale PC -
QMOVE.

La finestra BUS Information (Figura 63) visualizza la composizione hardware e le versioni/release dei firmware. Queste
informazioni vengono acquisite dalla CPU tra il BUS; per questo motivo sono disponibili solamente se la comunicazione ¢ attiva.

N° SLOT: posizione nello slot.

ID: identifica il tipo di scheda installata.

VERSION: indica la versione del firmware installato sulla scheda.
RELEASE: indica la release del firmware installato sulla scheda.

e WDOGBUS: segnala le eventuali anomalie di funzionamento delle schede.

Figura 63: composizione bus.
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13.8 Menu Tools
13.8.1 Upgrade QCL Card Library

| Questo comando & sempre disponibile. |

I comando Upgrade QCL Card Library permette di aggiornare le librerie del linguaggio QCL (Figura 64). Tali librerie contengono
informazioni relative a:

¢ Set dei modelli di QMOVE utilizzabili.
¢ Set di schede installabili sul QMOVE.
¢ Set di device presenti nel QMOVE.
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Figura 64: aggiornamento librerie.
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13.8.2 Upgrade QCL Functions Library

| Questo comando & sempre disponibile. |

Il comando Upgrade Functions Library permette di aggiornare le librerie di funzioni QCL (Figura 65).

Figura 65: aggiornamento librerie delle funzioni QCL.
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13.8.3 Upgrade Ladder Elements Library

| Questo comando e sempre disponibile. |

Il comando Upgrade ladder elements permette di aggiornare le librerie degli elementi ladder (Figura 67).

Figura 67: aggiornamento librerie Ladder.
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13.9 Menu Options

| comandi del menu Options permettono di personalizzare alcune funzionalita di QVIEW.
13.9.1 Open COM / Close COM

Permette di aprire e chiudere la porta di comunicazione seriale PC - QMOVE.

13.9.2 Program Setup ...

| Questo comando & sempre disponibile. |

Viene presentata una finestra composta da sei diverse cartelle.

13.9.2.1 Cartella QCL Editor

| Questo comando & sempre disponibile. |

Permette di personalizzare I'interfaccia grafica di QVIEW, assegnando dimensioni e colori diversi in funzione del testo QCL da
editare (Figura 68).

| Figura 68: personalizzazione editor QCL. |
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* Font Size: definisce le dimensione del font utilizzato nella finestra di editor.

Tab Stop: definisce la lunghezza della tabulazione.
Text Color: definisce il colore del testo (codice QCL).
Element Color: permette di specificare il colore dell’elemento selezionato.
Element Name: permette di selezionare gli elementi dell’editor per specificarne il colore. Gli elementi
selezionabili sono:
o Text: testo presente nell’editor.
Background: sfondo della finestra di editor.
Comments: commentipresenti nel programma.
Keywords: parole chiave.
Operators: operatori.
Constant: costanti.
Breakpoint: simbolo di breakpoint.
Program Counter: puntatore di programma (visibile solamente in condizioni di stop).
Border Background: bordo della finestra di editor.

0O O O O O O O O

13.9.2.2 Cartella Ladder Editor

Permette di personalizzare I'interfaccia grafica di QVIEW, assegnando dimensioni e colori diversi agli elementi che conpongono
|'editor LADDER (Figura 69).

Figura 69: personalizzazione editor Ladder.
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- Cell Width: definisce la larghezza delle caselle dell’editor.

- Cell Height: definisce I'altezza delle caselle dell’editor.

- Undo Levels: numero massimo di UNDO possibili.

- Cursor type: scelta del tipo di cursore.

- End Rung Mode: scelta del tipo di fine rung.

- Grid Drawing Style: scelta del tipo di tratto utilizzato per disegnare la griglia.

- Element Placing Style: grafica utilizzata come sfondo degli elementi LADDER selezionati.

- Element Contour Style: grafica utilizzata come sfondo dell’area dell’editor selezionata.

- Grid Visible: seleziona se rendere visibile la griglia.

- Note image Visible: seleziona se rendere visibili il simbolo che indica la presenza di una nota associata ad un elemento LADDER.
- Row Number visible: seleziona se rendere visibile i numeri di riga.

- Rung Number visible: seleziona se rendere visibile i numeri di rung.

- Obsolete State Visible: seleziona se indicare gli elementi LADDER obsoleti (cambiandone i Icolore di sfondo).

- Automatic New Rung Generation: seleziona se rendere possibile la generazione automatica dei rung al momento dell’inserimento di
un nuovo elemento LADDER.

- Automatic Element Property Editor: seleziona se far apparire automaticamente la finestra con le proprieta dell’elemento LADDER
una volta che viene inserito.

- Color: definisce il colore dello sfondo della finestra di editor.

- Element Color: permette di specificare il colore dell’elemento selezionato.
- Element Name: permette di selezionare gli elementi dell’editor per specificarne il colore.
Gli elementi selezionabili sono elencati in questa finestra.

In questa sezione del “Program Setup” e possibile associare ad una serie di HotKeys (Tasti Caldi) I'inserimento degli elementi
LADDER pil utilizzati. Nella Figura 70 & possibile vedere che & possibile associare I'inserimento di 10 elementi LADDER alla
combinazione dei tasti CTRL + ALT + 0...9 e altri 10 a CTRL + SHIFT + 0...9. Esiste gia un associamento per default, ma il
programmatore potra modificarlo.

Figura 70: associazione ai tasti caldi. |
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13.9.2.3 Cartella Communication

Per utilizzare le porte COM3 e COM4 é necessario adottare degli IRQ diversi da quelli utilizzati per altri dispositivi
hardware (mouse, COM1, COM2, ...).

Permette di configurare la porta di comunicazione seriale (Figura 71).

Figura 71: impostazione parametri porta di comunicazione seriale.
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- COM Port: permette di selezionare la porta di comunicazione seriale da utilizzare. - Communication Speed: definisce la velocita di
trasmissione della comunicazione seriale; selezionando I'opzione autodetect, QVIEW rileva automaticamente la velocita di
trasmissione da adottare.

E’ possibile selezionare tra due gruppi di impostazione dei tempi della comunicazione seriale (Timeouts Group A e Timeouts Group B).
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13.9.2.4 Cartella General

Permette di personalizzare I'ambiente di sviluppo (Figura 72).

Figura 72: impostazioni generali.
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- View Toolbar: abilita la visualizzazione della toolbar del progetto.

- View Status Bar: abilita la visualizzazione della barra di stato.

- View Ladder Toolbar: abilita la visualizzazione della toolbar del ladder.

- View Logo At Startup: abilita la visualizzazione del logo Qview allo startup del programma.

- View Ladder Warnings: abilita la visualizzazione dei messaggi di warning nella finestra con i risultati della compilazione.

- Automatic Project Backup: abilita I'esecuzione di una copia di backup del progetto ogni volta che viene salvato.

- Open the last project at startup: abilita I'apertura dell’ultimo progetto salvato ad ogni apertura del Qview.

- Export unit before remove it: abilita |a richiesta di esportazione dell’unita prima della cancellazione della stessa.

- View Compilation Warning report: abilita la visualizzazione dei messagi di warning durante la compilazione.

- Export Binary file After Compilation: abilita I'esportazione automatica del file binario risultato della compilazione.

- Export symbol file after compiling: abilita I'esportazione automatica del file simboli ad ogni compilazione andata a buon fine. Il file
simboli verra' esportato nella stessa directory del file di progetto con lo stesso nome del file di progetto. Se il progetto & nuovo e non
ancora salvato su disco, Qview generera una finestra di dialogo per chiedere dove ubicare il file simboli.

- Automatic Project Information update: se selezionato appare un messaggio in cui si chiede all'utente se le informazioni di progetto
contenute in “Project information” sono state aggiornate.

Questo messaggio appare se I'applicativo non viene salvato da almeno un’ora.

- Project Information update before project saving: se selezionato, ogni volta che si salva il progetto, appare un messaggio in cui si
avvisa che i dati obbligatori (segnalati con un asterisco) da inserire in “Project information” non sono completi.

In questa finestra & possibile salvare le impostazioni in un file e specificare anche alcuni dati relativi all’autore.
13.9.2.5 Cartella Net Configurations

Permette di impostare i dati necessari ad inviare un'email direttamente da Qview4 senza l'ausilio di un mail client esterno (Figura
73).

| Vedi figura 73: impostazioni generali. |
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- Mail From...: in questo campo & possibile impostare I'indirizzo da dove la mail dovra' partire. Tale indirizzo potrebbe essere il proprio
indirizzo email.

- Mail To...: e l'indirizzo di chi ricevera la mail. Solitamente va impostato come support@gem.it, ma & possibile impostare liberamente
anche altri indirizzi email.

- User ID: ID Utente necessario per effettuare il collegamento al provider di servizi internet (ISP).

- SMTP Host: e I'indirizzo del server di posta elettronica.

- Port: & la porta IP di comunicazione. Generalmente il valore 25 ¢ corretto per la stragrande maggioranza dei casi.

13.10 Menu Help

| Questo comando & sempre disponibile. |

Dal menu help e possibile richiamare gli help in linea e alcune informazioni su QVIEW.
13.10.1 Contents

Richiama I'help in linea relativo al linguaggio di programmazione.
13.10.2 QCL Language guide

Richiama I'help in linea per la programmazione in QCL.

13.10.3 Ladder Functions info

Richiama I'help in linea relativo agli elementi LADDER.

13.10.4 Functions info

Richiama I'help in linea relativo alle funzioni QCL.

13.10.5 User Functions info

Richiama I'help in linea relativo alle funzioni QCL realizzate dall’'utente.
13.10.6 Technical Info

Per accederte a Technical Info bata selezionare: TECHNICAL INFO. Viene visualizzata la finestra di figura 74 dove vengono raccolte
tutte le informazioni del Personal Computer nel quale ¢ istallato il Qview, complete di impostazioni e setup particolari , vengono
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inoltre registrate le DLL utilizzate per permettere di avere il massimo numero di informazioni possibili.

Una volta raccolte tutte queste informazioni, € possibile trasferirle in modo automatico su un documento Word pronte per essere
inviate per Email (Figura 76), oppure si puo eseguire I'invio di queste informazioni via email in modo automatico direttamente da
Qview 4 (Data Operations).

Figura 74: informazioni relative ai software e hardware installati.
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Le informazioni sono suddivise in tre categorie.

- PC System Info: raccoglie tutte le informazioni Hardware e Software del Computer con il quale si sta lavorando.
- Quiew System Info: raccoglie tutte le informazioni relative al programma Qview che si sta utilizzando.

- Project Information Info: raccoglie tutte le informazioni relative al progetto aperto in Qview.

13.10.7 About Qview

Viene visualizzata la versione di QVIEW e gli estremi per contattare la QEM srl.
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» 14. Debug

Come e stato anticipato all’inizio di questo manuale, QVIEW & un indispensabile supporto per la programmazione in QCL e LADDER,

sia per la stesura e la compilazione del codice, sia per il debugging del progetto realizzato.

Cos'e il debugging? Solitamente il tempo impiegato per la realizzazione di un progetto si suddivide in maniera equa tra il tempo per
la programmazione e il tempo per la correzione degli errori. Il debugging € I'insieme di tutte le operazioni che permettono di rilevare
questi errori che causano funzionamenti non desiderati. Gli strumenti che il QCL e LADDER mette a disposizione sono i seguenti:

o Esecuzione passo-passo del progetto (Step).

o Esecuzione passo-passo del singolo modulo (Step over).
o Inserimento di breakpoint.

o Watchpoint.

14.0.1 Esecuzione passo-passo

Una volta compilato e fatto il download, & possibile mettere in esecuzione I'applicativo scaricato selezionando il comando Run dal
menu Debug; & anche possibile eseguire un’istruzione per volta, selezionando il comando Step dal menu Debug.

Ad ogni comando di Step, si puod osservare lo scorrere di una istruzione; sull’editor viene evidenziata la riga di codice in esecuzione
con una freccia sul bordo sinistro della finestra. Durante la scansione del codice, si pud osservare I'effettivo flusso delle istruzioni ed il
valore delle variabili.

Il comando Step esegue fedelmente la successione delle istruzioni QCL e LADDER e, la visualizzazione sull’editor, si sposta di unit in
unit quando incontra un’istruzione di WAIT. Nel caso di unit scritte in LADDER I'esecuzione passo-passo consiste nel eseguire il codice
un rung per ogni passo.

14.0.2 Esecuzione passo-passo della singola unit

Il comando Debug > Step Over ha lo stesso effetto del comando Step; la successione delle istruzioni visualizzate si limita pero a
quelle dell’unita visualizzata sull’editor. E’ un comando utile per la scansionare il codice contenuto in una sola delle unita componenti
il progetto.

14.0.3 Inserimento di breakpoint

Il breakpoint € un punto preciso del programma in cui I'esecuzione del progetto si deve interrompere. Per fissare un breakpoint,
posizionare con il cursore nel punto dell’editor in cui si desidera bloccare il programma e selezionare il comando Debug > Toggle

Breakpoint; in corrispondenza dell’introduzione del breakpoint viene visualizzato il simbolo @ . Con comando di RUN il
programma verra eseguito fino all'istruzione marcata dal breakpoint (esclusa) e quindi si blocchera; la CPU assumera lo stato di
STOP. Nella finestra CPU si accendera il LED Breakpoint per indicare I'intervento di un breakpoint. Sull’editor la riga interessata dal

breakpoint viene indicata con il simbolo . Con un nuovo RUN il programma verra eseguito ancora una volta fino ad incontrare di
nuovo il breakpoint. Questa funzionalita € molto utile per osservare lo stato delle variabili in un certo punto del codice che non
sarebbe possibile apprezzare in fase di esecuzione normale. Inoltre il sistema del breakpoint puo essere usato per vedere se una
parte di codice viene eseguita oppure no. E’ possibile posizionare un numero massimo di 7 breakpoint contemporaneamente lungo il
codice. Nel caso ci siano piu di un breakpoint per visualizzare velocemente il punto del codice su cui si & bloccato il programma si pud

oo
usare I'icona "™ (Go To PC).
14.0.4 Watchpoint

Il watchpoint & un breakpoint condizionato dal valore di una variabile, di un ingresso o di un’uscita digitale, di un array, di un Data
Group o di un parametro di un device.

La domanda a cui risponde il watchpoint &: in che punto del programma un parametro o una variabile fissata acquisisce il valore
impostato?

Selezionando Debug > WatchPoint, appare la finestra Watchpoint List (Figura 1). Questa finestra contiene il parametro su cui
impostare il watchpoint e il valore a cui deve “scattare”.

Figura 1:elenco watchpoint.
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Con il tasto Add & possibile scegliere nome e tipo di parametro da usare per il watchpoint.
Una volta introdotte queste informazioni, digitare il valore al quale il watchpoint si deve attivare per bloccare I'esecuzione del
programma.
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e 15. Le librerie QCL

Le librerie QCL sono una componente fondamentale per il compilatore QCL, mettendo a disposizione - in fase di compilazione - una
serie di informazioni riguardanti i device e I'hardware. Tali informazioni sono necessarie per sapere quali parametri utilizza un device
interno, le loro caratteristiche e la loro collocazione in memoria; quali comandi sono disponibili per quel determinato device e la sua

sintassi di configurazione.

Al momento della realizzazione di un nuovo progetto & quindi necessario verificare che la versione di QVIEW installata contenga le
librerie necessarie per la gestione dei devices e dell’hardware da utilizzare (fare riferimento alle schede tecniche hardware).

Selezionare la voce Technical Info dal menu Help; Appare la finestra di figura 1.

Figura 1: componenti software installati.
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Alla riga LIBRARY viene specificato I'identificatore della libreria in uso (nell’esempio 1LIB3004).
Nel caso non si sia in possesso delle librerie richieste & necessario fare I'upgrade delle stesse selezionando Upgrade Library... dal

menu Tools e seguire le istruzioni proposte nelle finestre che appariranno.
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» 16. Appendice A: Limitazioni QCL

16.0.1 Numero massimo di etichette

Durante la compilazione di alcune istruzioni QCL il compilatore genera internamente delle etichette che vengono utilizzate per
successive elaborazioni. Esiste un limite di 999 etichette generabili per ogni unita, superato il quale non & possibile compilare il file
sorgente. Per conoscere il numero di etichette interne generate bisogna sapere che le istruzioni IF, ELSE, CALL, SUB, o label (es.
MAIN) generano una etichetta, mentre le istruzioni FOR e WHILE ne generano due. L'unica soluzione € quella di eliminare dal
sorgente alcune delle istruzioni viste sopra e rientrare nei limiti ammessi.

16.0.2 Numero massimo di operandi annidati

Durante la compilazione di espressioni il massimo numero di operandi annidati e 6.
Ad esempio una istruzione di questo tipo € ammessa:

Variabile = 1+(1+(1+(1+(1+1))))

mentre questa provoca un errore:

Variabile = 1+(1+(14+(1+(1+(1+1)))))

16.0.3 Numero massimo di elementi

Il numero massimo di elementi e passi ammessi in un datagroup & di 65534. Il compilatore segnala errore se tale limite viene
superato.

16.0.4 Dimensione massima di un Array

La dimensione massima di un array (sia ARRSYS che ARRGBL) & di 65535 elementi. Il compilatore segnala errore se tale limite viene
superato.

16.0.5 Ciclo FOR
Il passo di incremento in un ciclo FOR deve essere numerico. Non & possibile usare variabili o espressioni.
16.0.6 Datagroup

Nella dichiarazione di un datagroup la sottosezione DATAPROGRAM e obbligatoria.
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« 17. Appendice B: Conversione e promozione di tipo

17.1 Conversione di tipo

E importante ricordare che una conversione dal tipo intero (Flag, Byte Word o Long) al tipo Single non corrisponde ad
un aumento di precisione ma cambia solamente il formato in cui il valore é rappresentato.

Per espressione si intende un insieme di operatori, costanti e variabili che, risolti, definiscono un valore numerico risultante. Il QCL
mette a disposizione I'operatore di assegnamento “=" nella forma generale:

variabile = espressione

Non sono supportate le assegnazioni multiple tipo variabile = variabile = espressione

Per quanto riguarda I'istruzione di assegnamento, la regola di conversione & semplice: il QCL converte il valore alla destra del segno
uguale nel tipo del dato sinistro.

Esempio:
Consideriamo le seguenti variabili:

SYSTEM
sfFlag F
sbByte B
swWord W
sllong. L
ssSingle S

sbByte = swWord
Viene eliminato il primo byte della variabile swWord assegnando a sbByte solo il byte meno significativo. Se il valore di swWord &

compreso tra 127 e -128 i due valori risultano uguali e non viene eseguito alcun troncamento. Se il valore di swWord & esterno ai
valori precedentemente considerati il valore di sbByte riflette solamente il valore del byte meno significativo di swWord.

ssSingle = slLong
Il valore di slLong viene convertito nel formato reale a singola precisione.

sfFlag = ssSingle
La variabile sfFlag viene assegnata al valore 1 se ssSingle rappresenta un valore diverso da zero.

17.2 Promozione di tipo

Quando in una espressione sono utilizzati dati di tipo differente, il compilatore QCL li converte tutti nello stesso tipo e, in particolare,
nel tipo della dimensione che occupa piu memoria, secondo quella che nei linguaggi viene definita promozione di tipo. Dopo che il
compilatore ha applicato queste regole di conversione ogni coppia di operandi risulta della stessa dimensione che sara anche la
dimensione del risultato.

Ad esempio:

Variabile = (sbByte*sfFlag) + (swWord / sbByte) - (ssSingle+sfFlag)

Prima il compilatore converte sfFlag in BYTE e calcola il valore della moltiplicazione, poi il secondo sbByte in WORD e calcola il valore
della divisione, poi sfFlag in SINGLE e calcola il valore della somma; il risultato di sbByte*sfFlag viene convertito in Word e ne calcola
il valore. Quindi, questo risultato viene promosso a SINGLE per eseguire la sottrazione con il risultato di ssSingle+sfFlag.

Per quanto riguarda le costanti nelle espressioni, vengono convertite sempre nel tipo intero (FLAG, BYTE, WORD o LONG) della
dimensione piu indicata per contenere il valore (se nella costante non vi ¢ il punto decimale). Se la costante contiene il punto
decimale, viene convertita in tipo SINGLE.

Esempio:

Variabile = swWord / sbByte

con swWord =5 e shByte = 2
Variabile risulta di tipo WORD con valore 2 perdendo cosi la parte decimale.

Se si riscrive |'espressione come:
Variabile = (swWord * 1.0) / sbByte
con swWord =5 e shByte = 2

Variabile risulta di tipo SINGLE con valore 2,5. Questo perché il prodotto della variabile swWord con una costante con parte decimale
provoca la conversione del risultato in SINGLE.
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« 18. Appendice C: Convenzioni di scrittura

Consigliamo i programmatori di seguire delle semplici convenzioni di scrittura del codice. Tali convenzioni non sono obbligatorie per il
funzionamento, ma aiutano

o la leggibilita del codice scritto sia dallo stesso programmatore che da un secondo;
o a ridurre la possibilita di errori nella programmazione.

Le regole sono:

1. usare simboli in lingua inglese;

2. usare i caratteri maiuscoli per i nomi delle costanti e delle subroutine. Per separare le parole si puo usare il
carattere '_'.

3. Tutte le variabili locali (non visibili all'esterno della unit) devono avere un nome tutto minuscolo. Per separare
le parole si puo usare il carattere ' ' (Esempio: check_config_result).

4. Le variabili locali che invece hanno visibilita all'esterno (IN, OUT o INOUT) hanno tutti i caratteri di cambio
parola in maiuscolo. Non si usa in queste il carattere '_' (Esempio: AccelerationTime).
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« 19. Appendice D: Parole chiave

In questo capitolo vengono riassunte le parole chiave del QCL.

ABS valore assoluto

ACOS arcocoseno

AND AND logico

ANDB And logico bit a bit

APPLICATION Radice implicita di ogni simbolo utilizzato
ARRGBL sezione file di configurazione
ARRSYS sezione file di configurazione
ASIN arcoseno

ATAN arcotangente

B byte

BEGIN sezione codice operativo nella unit
BREAK break

BUS sezione file di configurazione
CALL chiamata subroutine

CASE istruzione SWITCH-CASE

CEIL arrotondamento a intero non inferiore a quello dato
CONST sezione file di configurazione

CoS coseno

COoT cotangente

D double

DATAGROUP sezione file di configurazione
DATAPROGRAM | sezione file di configurazione
DEVGROUP inizio raggruppamento device
ELSE “altrimenti” nell'istruzione IF

END fine task

ENDDEVGROUP | fine raggruppamento device
ENDIF fine istruzione IF

ENDSUB fine subroutine

ENDSWITCH fine SWITCH

ENDWHILE fine while

EQ uguale

EXP esponenziale

EXTDEVICE sezione file di configurazione

F flag

FLOOR arrotondamento a intero non superiore a quello dato
FOR istruzione FOR

FPROG istruzione FPROG

FSTEP istruzione FSTEP

GE maggiore uguale

GLOBAL sezione file di configurazione

GT maggiore

IF istruzione IF

INPUT sezione file di configurazione
INTDEVICE sezione file di configurazione
ISFINITE controlla se il valore e finito

ISINF controlla se il valore ¢ infinito
ISNAN controlla se il valore € Nan (Not a Number)
ISNORMAL controlla se il valore € normale
JUMP istruzione JUMP

LE minore o uguale

LN logaritmo naturale

LT minore

MULDIV moltiplicazione e divisione

NEG negazione (inversione del segno o complemento a 2)
NEQ operatore

NEXT istruzione NEXT

NOP istruzione NOP

NOT negazione

NOTB negazione bit a bit (complemento a 1)
OR OR logico

ORB OR logico bit a bit
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OUTPUT sezione file di configurazione
POW potenza

REFERENCE proprieta di “riferimento” di un simbolo
REFERENCES inizio dell'elenco dei riferimenti
RESOUT reset uscite

RESTART istruzione di restart

RESUME istruzione di resume

RETURN istruzione di return (su subroutine)
RMULDIV resto di moltiplicazione e divisione
ROUND arrotondamento a intero pil vicino
S single

SETOUT setta uscita

SHLL shift a sinistra

SHLR shift a destra

SIN seno

SQRT radice quadrata

STEP sezione file di configurazione

SUB subroutine

SUSPEND istruzione di sospensione

SWITCH istruzione SWITCH-CASE

SYSTEM sezione file di configurazione

TAN tangente

TIMER sezione file di configurazione
TRUNC arrotondamento a intero non maggiore di grandezza
w word

WAIT istruzione di wait

WHILE istruzione di while

XORB OR esclusivo bit a bit

#DEFINE
#UNDEF
#IFDEF
#IFNDEF
#ELSE
#ENDIF
#ERROR

Oltre a queste vanno considerate le direttive del precompilatore
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« 20. Appendice E: Tasti caldi

F1 Contenuti (Contents)

F2 -

F3 Prossima ricerca (Find Next)

F4 Prossima unita (Next Unit)

F5 Run

F6 Stop

F7 Restart

F8 Step

F9 Toggle breakpoint

F11 Vai a PC (Go to PC)

F12 Prossima unita selezionata (Next selected unit)
SHIFT + F2 | Functions Info

SHIFT + F4 | Unita precedente (Previous Unit)

SHIFT + F5 | Move Rows Up (Editor LADDER)

SHIFT + F6 | Move Rows Down (Editor LADDER)

SHIFT + F8 | Step Over

SHIFT + F9 | Clear All

SHIFT + F12 | Unita selezionata precedente (Previous selected unit)
CTRL + A Redo

CTRL + C Copia

CTRL + E Proprieta dell'elemento LADDER (Element Properties...)
CTRL + F Trova (Find)

CTRL + G Vai a (Go to)

CTRL + K Compila (Compile)

CTRL + L Download

CTRL + N Salva progetto con altro nome (Save project As...)
CTRL + P Stampa (Print)

CTRL + R Sostituisci (Replace)

CTRL + S Salva progetto (Save project)

CTRL+ T Ladder Network Checking

CTRL + V Incolla

CTRL + X Taglia

CTRL + Z Undo

CTRL + F1 Ladder Function Info

CTRL + F2 Functions Info

CTRL + F3 Risultati della compilazione (View compilation results)
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« 21. Appendice F: Files generati
21.1 File *.qmé6: file di progetto
Viene creato da QVIEW dopo I'esecuzione del comando New Project. E un file unico per ogni applicazione.

21.2 File derivante dalla compilazione

21.2.1 File *.sym

E’ un file simboli utilizzato per la gestione dell'interfaccia operatore (terminale). Serve per I'applicazione realizzata per I'interfaccia
operatore. Contiene tutte le informazioni per poter accedere alle variabili dichiarate nel progetto.

21.2.2 File *.xml

E’ un file simboli utilizzato per la gestione avanzata degli stessi da parte dei tools della QNET. Contiene tutte le informazioni per poter
accedere alle variabili dichiarate nel progetto.

21.2.3 File *.bin

E’ un file risultato della compilazione che puo essere utilizzato per essere trasferito nella CPU senza utilizzare la comunicazione
seriale (per esempio con Multi Media Card).
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« 22. Appendice G: Compatibilita con le versioni precedenti

L'ambiente di sviluppo & pienamente compatibile con le versioni e release precedenti.
Un progetto realizzato con Qview3, Quiew 4 e Qview 5 potra essere aperto con il Qview 6.

Al momento dell'apertura di un progetto realizzato con Qview precedenti, il Qview 6 applica delle trasformazioni automatiche di
alcune parti di codice per adattarle alla nuova notazione. Queste trasformazioni sono:

Tipo di accesso Versioni precedenti Qview 6
Comandi ai device <command name> <device name> | <device name>.<command name>
Parametri dei device <device name>:<parameter/state> | <device name>.<parameter/state>
Variabili di sistema QMOVE: <system variable name> QMOVE.<system variable name>
T _RESTART <unit name> <unit name>.RESTART
Controlli schedulazione unit | T_RESUME <unit name> <unit name>.RESUME
T _SUSPEND <unit name> <unit name>.SUSPEND
Stato di sospensione unit QMOVE:is_suspend <unit name> <unit name>.is_suspended
Dimensione array <array name>:dim <array name>.dim
Tempo rimanente timer <timer name>:remain <timer name>.remain

Al momento della compilazione di un progetto realizzato con Qview precedenti, € possibile che vengano notificati degli errori da
Qview 6 che con i Qview precedenti non erano stati rilevati. Li elenchiamo di seguito:

o Non e possibile utilizzare lo stesso nomi per una label e per una subroutine o per una costante.
o Non e possibile scrivere le subroutine prima della istruzione END di una unit. Le SUB vanno sempre scritte alla
fine della unit e dopo I'END.

Documento generato automaticamente da Qem Wiki - https://wiki.gem.it/
Il contenuto wiki & costantemente aggiornato dal team di sviluppo, € quindi possibile che la versione online contenga informazioni
piu recenti di questo documento.

94/94


https://wiki.qem.it/

	Sommario
	QVIEW 6.0
	1. Introduzione
	1.1 QVIEW: QMOVE VIEWer
	1.2 QCL: QEM Control Language
	1.3 Ladder
	1.4 I Device
	1.5 QPaint

	2. Introduzione all’ambiente
	2.1 Apertura e creazione del progetto di esempio
	2.1.1 Creare un nuovo progetto
	2.1.1.1 Configuration unit
	2.1.1.2 QCL unit

	2.1.2 Compilazione del progetto di esempio

	2.2 Connessione del PC al QMOVE
	2.3 Trasferimento del progetto compilato nella CPU (Download)
	2.4 Monitoraggio del funzionamento

	3. Introduzione alla programmazione
	3.1 Dichiarazioni
	3.1.1 Unit di configurazione
	3.1.2 Unit operative

	3.2 Tipi di variabili
	3.2.1 Flag
	3.2.2 Byte
	3.2.3 Word
	3.2.4 Long
	3.2.5 Single
	3.2.6 Double
	3.2.7 Tabella riassuntiva dei tipi di variabili utilizzabili

	3.3 Gli Identificatori
	3.3.1 I nomi

	3.4 Le costanti
	3.5 Le variabili SYSTEM
	3.6 Le variabili GLOBAL
	3.7 Le variabili ARRAY SYSTEM
	3.8 Le variabili ARRAY GLOBAL
	3.9 Le variabili TIMER
	3.10 Le variabili INPUT ed OUTPUT
	3.11 Le variabili DATAGROUP
	3.11.1 Variabili Statiche
	3.11.2 Variabili Indicizzate

	3.12 Sezione BUS

	4. Visibilità delle variabili
	4.1 Variabili di configurazione
	4.2 Variabili locali
	4.3 Variabili IN/OUT/INOUT
	4.3.1 IN
	4.3.2 OUT
	4.3.3 INOUT

	4.4 APPLICATION

	5. REFERENCE
	6. COSTANTI
	7. Istruzioni QCL
	7.1 Gli operatori del QCL
	7.1.1 Operatore di assegnamento
	7.1.2 Operatori aritmetici
	7.1.3 Operatori logici
	7.1.4 Operatori binari
	7.1.5 Operatori relazionali
	7.1.6 Gli operatori di livello di precedenza
	7.1.7 Livelli di priorità degli operatori del QCL

	7.2 Istruzioni e strutture per il controllo del flusso
	7.2.1 IF / ELSE / ENDIF
	7.2.2 FOR-NEXT
	7.2.3 WHILE-ENDWHILE
	7.2.4 SWITCH-ENDSWITCH
	7.2.5 WAIT
	7.2.6 JUMP
	7.2.7 ETICHETTE
	7.2.8 SUBROUTINE
	7.2.9 CALL
	7.2.10 NOP

	7.3 Istruzioni dedicate alle uscite digitali
	7.3.1 SETOUT
	7.3.2 RESOUT

	7.4 Istruzioni di sistema
	7.4.1 SUSPEND
	7.4.2 RESUME
	7.4.3 RESTART

	7.5 Variabili di sistema
	7.5.1 is_suspended
	7.5.2 watchdog
	7.5.3 time_task_lost
	7.5.4 battery_low
	7.5.5 battery_down

	7.6 Funzioni matematiche
	7.6.1 Elevamento a potenza
	7.6.2 Radice quadrata
	7.6.3 Logaritmo naturale
	7.6.4 Esponenziale
	7.6.5 Valore assoluto
	7.6.6 Shift a sinistra
	7.6.7 Shift a destra
	7.6.8 Moltiplicazione e divisione
	7.6.9 Resto di moltiplicazione e divisione
	7.6.10 Arrotondamenti all'intero più vicino
	7.6.11 Operatori di classificazione

	7.7 Funzioni trigonometriche
	7.7.1 Seno
	7.7.2 Coseno
	7.7.3 Tangente
	7.7.4 Cotangente
	7.7.5 Arcoseno
	7.7.6 Arcocoseno
	7.7.7 Arcotangente
	7.7.8 Avvertenza


	8. Applicazione di esempio
	8.1 Nuovo Progetto
	8.2 Aggiungi la unit di configurazione
	8.3 Aggiungi le unit QCL
	8.3.1 Unit MANAGER
	8.3.2 Unit SEQUENC
	8.3.3 Unit COMMAND


	9. Funzioni di libreria QCL
	9.0.1 Esempio di utilizzo delle funzioni QCL

	10. Editor Ladder
	10.1 L’esecuzione del rung
	10.2 Come inserire un elemento
	10.3 Categorie degli elementi
	10.4 Commenti
	10.5 Jump e Label
	10.6 Movimento delle righe LADDER
	10.7 Drag & Drop degli elementi LADDER
	10.8 Elementi LADDER obsoleti
	10.9 Sostituzione degli elementi obsoleti

	11. Multitasking
	11.1 Struttura standard di un task QCL
	11.1.1 Esempio di SUSPEND
	11.1.2 Esempio di RESUME
	11.1.3 Esempio di RESTART

	11.2 Unità a tempo
	11.3 Unità in interruzione

	12. Device
	12.1 Dichiarazione dei Device
	12.1.1 Dichiarazione device

	12.2 Utilizzo dei devices
	12.2.1 Tempo di campionamento
	12.2.2 Comandi consecutivi e loro priorità
	12.2.3 Comandi complementari

	12.3 Gruppi di device

	13. Ambiente Qview
	13.1 Barra degli strumenti
	13.2 Barra di stato
	13.3 Menu File
	13.3.1 New Project
	13.3.2 Open Project
	13.3.3 Save Project
	13.3.4 Save Project As
	13.3.5 Close Project
	13.3.6 Add Unit
	13.3.7 Insert Unit
	13.3.8 Creazione di una unit di configurazione
	13.3.9 Creazione di una unit QCL o LADDER
	13.3.10 Creazione di un unit di documentazione
	13.3.11 Remove Unit
	13.3.12 Import Unit
	13.3.13 Export Unit
	13.3.14 Export Unit As
	13.3.15 Unit Property
	13.3.16 Import Module As Unit
	13.3.17 Export Unit as Module
	13.3.18 Export Symbols File
	13.3.19 Export Symbols File As ...
	13.3.20 Export Binary File & Export Binary File As ...
	13.3.21 Project Information ...
	13.3.22 Print
	13.3.23 Richiamo ultimi progetti aperti
	13.3.24 Exit

	13.4 Menu Edit
	13.4.1 New Element
	13.4.2 New Rung
	13.4.3 Delete Rung
	13.4.4 Toggle Link
	13.4.5 Substitute Obsolete Element & Substitute All Obsolete Elements...
	13.4.6 Element Properties...
	13.4.7 Undo
	13.4.8 Redo
	13.4.9 Cut - Copy - Paste - Delete
	13.4.10 Select All
	13.4.11 Compact Rows
	13.4.12 Move Rows Up
	13.4.13 Move Rows Down
	13.4.14 Find
	13.4.15 Find Next
	13.4.16 Replace
	13.4.17 Go to ...
	13.4.18 Go to PC
	13.4.19 Next Unit / Previous Unit
	13.4.20 Next Selected Unit / Previous Selected Unit

	13.5 Menu: Project
	13.5.1 Compile
	13.5.2 Force Compile
	13.5.3 Ladder Network Checking
	13.5.4 View compilation result
	13.5.5 Download
	13.5.6 Backup data
	13.5.7 Restore data
	13.5.8 Save Data...
	13.5.9 Recall Data...
	13.5.10 Convert Data...
	13.5.11 Checksum View
	13.5.12 Project ID View

	13.6 Menu Debug
	13.6.1 Run
	13.6.2 Stop
	13.6.3 Restart
	13.6.4 Reset
	13.6.5 Step
	13.6.6 Step Over
	13.6.7 Toggle Breakpoint
	13.6.8 Clear All
	13.6.9 Watchpoint

	13.7 Menu Monitor
	13.7.1 Devices Panels
	13.7.2 CPU MONITOR
	13.7.3 General
	13.7.3.1 Task info
	13.7.3.2 CPU’s Oscilloscope

	13.7.4 BUS

	13.8 Menu Tools
	13.8.1 Upgrade QCL Card Library
	13.8.2 Upgrade QCL Functions Library
	13.8.3 Upgrade Ladder Elements Library

	13.9 Menu Options
	13.9.1 Open COM / Close COM
	13.9.2 Program Setup ...
	13.9.2.1 Cartella QCL Editor
	13.9.2.2 Cartella Ladder Editor
	13.9.2.3 Cartella Communication
	13.9.2.4 Cartella General
	13.9.2.5 Cartella Net Configurations


	13.10 Menu Help
	13.10.1 Contents
	13.10.2 QCL Language guide
	13.10.3 Ladder Functions info
	13.10.4 Functions info
	13.10.5 User Functions info
	13.10.6 Technical Info
	13.10.7 About Qview


	14. Debug
	14.0.1 Esecuzione passo-passo
	14.0.2 Esecuzione passo-passo della singola unit
	14.0.3 Inserimento di breakpoint
	14.0.4 Watchpoint

	15. Le librerie QCL
	16. Appendice A: Limitazioni QCL
	16.0.1 Numero massimo di etichette
	16.0.2 Numero massimo di operandi annidati
	16.0.3 Numero massimo di elementi
	16.0.4 Dimensione massima di un Array
	16.0.5 Ciclo FOR
	16.0.6 Datagroup

	17. Appendice B: Conversione e promozione di tipo
	17.1 Conversione di tipo
	17.2 Promozione di tipo

	18. Appendice C: Convenzioni di scrittura
	19. Appendice D: Parole chiave
	20. Appendice E: Tasti caldi
	21. Appendice F: Files generati
	21.1 File *.qm6: file di progetto
	21.2 File derivante dalla compilazione
	21.2.1 File *.sym
	21.2.2 File *.xml
	21.2.3 File *.bin


	22. Appendice G: Compatibilità con le versioni precedenti

